Xerox® ColorQube® 8580 / 8880 Color Printer
Imprimante Couleur
User Guide
Guide d'utilisation

Italiano  Guida per l'utente  
Deutsch  Benutzerhandbuch  
Español  Guía del usuario  
Português  Guia do usuário  
Nederlands  Gebruikershandleiding  
Svenska  Användarhandbok  
Dansk  Betjeningsvejledning  
Čeština  Uživatelská příručka  
Polski  Przewodnik użytkownika  
Magyar  Felhasználói útmutató  
Русский  Руководство пользователя  
Türkçe  Kullanıcı Kilavuzu  
Ελληνικά  Εγχειρίδιο χρήσης
# Contents

1. **Safety** ................................................................. 9
   - Electrical Safety .......................................................... 10
   - General Guidelines ....................................................... 10
   - Power Cord ................................................................. 11
   - Operational Safety ....................................................... 12
   - Ozone Release ............................................................ 12
   - Printer Location ........................................................ 12
   - Operational Guidelines .............................................. 13
   - Printer Supplies ......................................................... 13
   - Maintenance Safety .................................................... 14
   - Printer Symbols ......................................................... 15
   - Environmental, Health, and Safety Contact Information .................................................. 16

2. **Features** ............................................................. 17
   - Parts of the Printer ....................................................... 18
     - Front Right View ....................................................... 18
     - Right Side View ......................................................... 19
     - Rear View ............................................................... 19
     - Control Panel ........................................................... 20
   - Printer Configurations and Options ................................ 22
     - Standard Features .................................................... 22
     - Options and Upgrades ............................................... 23
   - Information Pages ...................................................... 24
     - Printing the Menu Map ............................................. 24
     - Viewing Information Pages ...................................... 24
     - Printing the Configuration Page .............................. 25
   - Sample Pages ............................................................ 26
   - More Information ...................................................... 27
     - Xerox® Welcome Center ........................................... 28

3. **Installation and Setup** ......................................... 29
   - Installation and Setup Overview .................................. 30
   - Selecting a Location for the Printer ............................... 31
   - Modifying General Settings ......................................... 32
     - Configuring General Setup Options ......................... 32
     - Setting the Date and Time ........................................ 32
     - Disabling the Startup Page ...................................... 33
     - Modifying Power Settings ....................................... 33
   - Connecting the Printer ............................................... 34
   - Printing the Connection Setup Page ............................ 34
# Contents

Selecting a Connection Method.......................................................................................................................... 34  
Configuring Network and Printer Settings........................................................................................................... 36  
About TCP/IP and IP Addresses .......................................................................................................................... 36  
Viewing the Automatically Assigned IP Address .................................................................................................. 36  
Assigning a Static IPv4 Address Manually ............................................................................................................ 37  
Accessing CentreWare Internet Services ............................................................................................................ 38  
Using PhaserSMART Technical Support ............................................................................................................... 39  
Installing the Software......................................................................................................................................... 40  
Before You Begin................................................................................................................................................ 40  
Operating System Requirements............................................................................................................................ 40  
Available Print Drivers....................................................................................................................................... 40  
Using Walk-Up Installation.................................................................................................................................. 41  
Installing the Print Drivers................................................................................................................................ 42  

## 4 Paper and Media

Supported Paper .................................................................................................................................................... 46  
Recommended Paper............................................................................................................................................ 46  
Ordering Paper...................................................................................................................................................... 46  
Paper That Can Damage Your Printer.................................................................................................................. 47  
Paper Storage Guidelines..................................................................................................................................... 47  
Paper Tips Page...................................................................................................................................................... 48  
Supported Paper Types and Weights....................................................................................................................... 48  
Supported Standard Paper Sizes........................................................................................................................... 49  
Supported Paper Types and Weights for Automatic 2-Sided Printing.................................................................. 49  
Supported Paper Sizes for Automatic 2-Sided Printing....................................................................................... 49  
Supported Custom Paper Sizes............................................................................................................................. 50  
Supported Envelope Sizes ..................................................................................................................................... 50  
Selecting Paper Options for Printing.................................................................................................................... 51  
Setting the Tray 1 Mode....................................................................................................................................... 51  
Setting the Tray 2 Mode....................................................................................................................................... 51  
Loading Paper....................................................................................................................................................... 53  
General Paper Loading Guidelines ....................................................................................................................... 53  
Loading Paper in Tray 1....................................................................................................................................... 54  
Loading Paper in Trays 2-5................................................................................................................................... 56  
Loading Paper for Automatic 2-Sided Printing..................................................................................................... 58  
Printing Special Paper......................................................................................................................................... 59  
Envelopes.............................................................................................................................................................. 59  
Labels.................................................................................................................................................................... 63  
Glossy....................................................................................................................................................................... 68  
Transparencies...................................................................................................................................................... 72  
Pre-Punched Paper.............................................................................................................................................. 76  
Using Custom Paper Sizes................................................................................................................................... 80  
Creating Custom Paper Sizes at the Control Panel.............................................................................................. 80  
Creating Custom Paper Sizes in the Print Driver ................................................................................................. 80  

## 5 Printing


Contents

Printing Overview ............................................................................................................................................. 82
Selecting Printing Options ............................................................................................................................. 83
Windows Printing Options ............................................................................................................................. 84
Macintosh Printing Options ......................................................................................................................... 85
Using Earth Smart Settings .......................................................................................................................... 86
Selecting a Print-Quality Mode ..................................................................................................................... 86
Printing Features ........................................................................................................................................... 88
Selecting Paper Options for Printing ......................................................................................................... 88
Page Orientation ............................................................................................................................................... 88
Printing on Both Sides of the Paper ............................................................................................................. 89
Printing Multiple Pages to a Single Sheet .................................................................................................... 90
Printing Booklets ......................................................................................................................................... 90
Image and Color Options ............................................................................................................................. 91
Printing Cover Pages .................................................................................................................................... 92
Printing Separator Pages .............................................................................................................................. 92
Scaling Options ............................................................................................................................................. 93
Printing Watermarks ..................................................................................................................................... 93
Printing Mirror Images ............................................................................................................................... 94
Printing Special Job Types ......................................................................................................................... 95
Secure Print .................................................................................................................................................. 95
Proof Print ..................................................................................................................................................... 96
Personal Print ............................................................................................................................................... 97
Saved Job ................................................................................................................................................... 97
Print With .................................................................................................................................................... 99

6 Maintenance .............................................................................................................................................. 101

Maintenance and Cleaning ......................................................................................................................... 102
General Precautions ..................................................................................................................................... 102
Cleaning the Printer ...................................................................................................................................... 104
Accessing Maintenance Information .......................................................................................................... 111
Routine Maintenance ................................................................................................................................... 112
Ordering Supplies ......................................................................................................................................... 119
Locating the Serial Number ......................................................................................................................... 119
When to Order Supplies .............................................................................................................................. 119
Consumables ............................................................................................................................................... 120
Viewing the Maintenance Kit Status ......................................................................................................... 120
Customer Replaceable Units ...................................................................................................................... 120
Recycling Supplies ..................................................................................................................................... 121
Moving the Printer ....................................................................................................................................... 122
Precautions for Moving the Printer ........................................................................................................... 122
Moving the Printer Within the Office .......................................................................................................... 123
Preparing the Printer for Shipment ............................................................................................................ 124

7 Troubleshooting ...................................................................................................................................... 127

General Troubleshooting ............................................................................................................................ 128
Minimizing Ink Usage ................................................................................................................................. 128
B  Regulatory Information  177

Basic Regulations .............................................................................................................................. 178
  United States FCC Regulations .................................................................................................. 178
  Canada ....................................................................................................................................... 178
  European Union ......................................................................................................................... 178
  European Union Lot 4 Imaging Equipment Agreement Environmental Information ........ 179
Material Safety Data Sheets .......................................................................................................... 181

C  Recycling and Disposal  183

All Countries .................................................................................................................................. 184
North America ............................................................................................................................... 185
European Union ............................................................................................................................ 186
  Domestic/Household Environment ............................................................................................ 186
  Professional/Business Environment .......................................................................................... 186
  Collection and Disposal of Equipment and Batteries ............................................................. 187
Battery Symbol Note .................................................................................................................. 187
Battery Removal .......................................................................................................................... 187
Other Countries .......................................................................................................................... 188
This chapter includes:

- Electrical Safety ................................. 10
- Operational Safety ...................................... 12
- Maintenance Safety ................................... 14
- Printer Symbols ........................................ 15
- Environmental, Health, and Safety Contact Information ............................... 16

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox printer.
Electrical Safety

Please read the following instructions carefully before operating your printer. Refer to these instructions to ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety agency evaluation and certification, and compliance with electromagnetic regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of external devices, can affect the product certification. Please contact your Xerox representative for more information.

General Guidelines

**WARNINGS:**

- Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a part could result in fire or electric shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Turn off the printer when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- The printer emits smoke, or the surface is unusually hot.
- The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.
Power Cord

- Use the power cord supplied with your printer.
- Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.

⚠️ **WARNING:** Avoid the potential of electrical shock by ensuring that the printer is grounded properly. Electrical products can be hazardous if misused.

- Only use an extension cord or power strip designed to handle the electrical current capacity of the printer.
- Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.
- Do not place the printer in an area where people can step on the power cord.
- Do not place objects on the power cord.
- Do not plug or unplug the power cord while the power switch is in the On position.
- If the power cord becomes frayed or worn, replace it.
- To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on print volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in North America, go to:
- Xerox® ColorQube 8580 Color Printer www.xerox.com/environment
- Xerox® ColorQube 8880 Color Printer www.xerox.com/environment

In other markets, contact your local Xerox representative or go to:
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/environment_europe
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/environment_europe

Printer Location

- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in an area where there is adequate space for operation and servicing.
- Place the printer in a dust-free area.
- Do not store or operate the printer in an environment of extreme temperature or humidity.
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight.
- Do not place the printer where it is exposed directly to the cold air flow from an air conditioning system.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at elevations recommended in Elevation on page 173.

See also:
- Clearance Requirements on page 172
- Environmental Specifications on page 173
- Physical Specifications on page 172
Operational Guidelines

- Do not remove any paper trays while the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
- Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the protective covers.

Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
- Store all supplies in accordance with the instructions given on the package or container.
- Keep all supplies away from the reach of children.
- Never burn supplies.
- When handling supplies, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble supplies, which can increase the risk of skin or eye contact.

⚠️ CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.
- Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
- Do not burn any consumables or routine maintenance items.

For more information on the Xerox® supplies recycling program, go to:
- Xerox® ColorQube 8580 Color Printer www.xerox.com/gwa
- Xerox® ColorQube 8880 Color Printer www.xerox.com/gwa

See also:
Cleaning the Printer on page 104
Moving the Printer on page 122
## Printer Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td><strong>Warning or Caution:</strong> Ignoring this warning could cause serious injury or even death. Ignoring this caution could cause injury or damage to the property.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Hot surface on or in the printer. Use caution to avoid personal injury.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td><strong>Warning:</strong> Moving parts. To avoid personal injury, use caution.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Parts of the printer are hot and need time to cool down before moving or packing the printer. To avoid personal injury or printer damage, wait 30 minutes for the ink to solidify and the printhead to cool down.</td>
</tr>
</tbody>
</table>
Environmental, Health, and Safety Contact Information

For product safety information in the United States and Canada, go to:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/environment.
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/environment

For product safety information in Europe, go to:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/environment_europe.
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/environment_europe.
Features

This chapter includes:

- Parts of the Printer ................................................................. 18
- Printer Configurations and Options ........................................... 22
- Information Pages ................................................................. 24
- Sample Pages ......................................................................... 26
- More Information ................................................................. 27
Parts of the Printer

This section includes:

- Front Right View ................................................................. 18
- Right Side View ........................................................................ 19
- Rear View ............................................................................... 19
- Control Panel ......................................................................... 20

Front Right View

1. Tray 2 with 525-sheet capacity
2. Tray 1, Multi-Purpose Tray (MPT) with 100-sheet capacity.
3. Control Panel
4. Handle for Door B
5. Door A Release Lever
6. Exit Door B
7. Door C for Ink Loading
8. Legal/A4 Output Tray Extension
9. Interface (I/O) Door E
10. Maintenance Door D
11. Front Door A
12. Tray 3, Optional 525-Sheet Feeder
13. Tray 4, Optional 525-Sheet Feeder
14. Tray 5, Optional 525-Sheet Feeder
Right Side View

1. Maintenance Kit  
2. Waste Tray  
3. Power Cord Connection  
4. Power Switch  
5. USB Connection  
6. Configuration Card  
7. Ethernet 10/100/1000Base-TX Connection

Rear View

1. Optional Solid-state Drive  
2. One RAM Slot
Control Panel

The control panel consists of a display, indicator lights, and buttons you press to control the functions available on the printer. The control panel:

- Displays the current operating status of the printer.
- Provides access to print features.
- Provides access to reference materials.
- Provides access to administrative and maintenance menus.
- Prompts you to load paper, replace supplies, and clear jams.
- Displays errors and warnings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Symbol</th>
<th>Control Panel Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>—</td>
<td>Status Indicator</td>
<td>This light changes colors to indicate various states of readiness of the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A green light indicates that the printer is ready to receive data and print.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A blinking green light indicates that the printer is busy or warming up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A yellow or orange light indicates a warning condition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A red light indicates an error condition.</td>
</tr>
<tr>
<td>2</td>
<td>—</td>
<td>Display Screen</td>
<td>The display screen shows all control panel menu options for the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The top line displays status messages and menu title information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The bottom lines display menus and menu options that you can navigate to.</td>
</tr>
<tr>
<td>3</td>
<td>C️</td>
<td>Cancel Button</td>
<td>The Cancel button ends the current print job.</td>
</tr>
<tr>
<td>4</td>
<td>🔷</td>
<td>Back/Return Button</td>
<td>The Back button returns you to the previous menu item.</td>
</tr>
<tr>
<td>5</td>
<td>🔬</td>
<td>Up and Down Arrow Buttons</td>
<td>Use the arrow buttons to navigate through the menus.</td>
</tr>
<tr>
<td>6</td>
<td>OK</td>
<td>OK Button</td>
<td>The OK button selects the current menu option or displays the results of a menu selection.</td>
</tr>
<tr>
<td>7</td>
<td><img src="image" alt="Help Button" /></td>
<td>Help Button</td>
<td>The Help (?) button displays information about control panel menu items, printer status, error messages, or maintenance information.</td>
</tr>
<tr>
<td>---</td>
<td>-----------------------</td>
<td>-------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 8 | ![Power Saver Button](image) | Power Saver button | **Power Saver** enters and exits low-power mode.  
When the Power Saver button is illuminated, to put the printer into Power Saver mode, press the **Power Saver** button.  
- To return the printer to Ready mode, press the **Power Saver** button.  
- When the light blinks, the printer is in Power Saver mode.  
- When the light is off, the printer cannot be put into Power Saver mode. |
Printer Configurations and Options

This section includes:

- Standard Features ................................................................. 22
- Options and Upgrades ............................................................. 23

Standard Features

The printer provides the following features:

- 1 GHz processor
- 1-GB RAM memory, expandable up to 2-GB, available in a single DDR3 SDRAM slot that supports 1-GB or 2-GB cards.
- Ethernet 10/100/1000Base-TX
- Universal Serial Bus (USB 2.0)
- Embedded PDL support for True Adobe PostScript 3, PCL 5c emulation, JPG, TIFF, PNG, and PDF
  
  Note: PDF printing requires use of the optional solid-state drive.

- PCL driver print-quality modes
  - PCL Standard Mode
  - PCL Enhanced Mode
- PostScript print-quality modes
  - Fast Color: Provides the fastest full-color mode prints. Use this mode when you have many images and for previewing your work.
  - Standard: Produces crisp, bright prints at high speed and is ideal for black text. Standard mode provides the best trade-off between performance and image quality for most jobs.
  - Enhanced: Use this mode for CAD applications and for fine detail printing with the best overall image quality. Lines and edges are enhanced for smoothness and black and dark colors are enhanced for richness.
  - Photo: This mode provides the best detail and smoothness for photographic images.

- RAM collation: This setting allows the printer to store jobs in memory so that multiple copies can print in page sequence order. Page sequence order prints pages according to page sequence for the job, for example 123, 123, 123. Copy number order prints pages according to the number of copies set for the job, for example 111, 222, 333.

- Tray 1 with 100-sheet capacity
- Tray 2 with 525-sheet capacity
- Cartridge-free solid ink
Options and Upgrades

The following options are available for your printer:

- Productivity Kit with a 32-GB mSata Solid-state drive
- Productivity Kit with expandable memory up to 2-GB, available in single DDR3 SDRAM slot that supports 1-GB or 2-GB cards
- Automatic 2-sided printing
- 1, 2, or 3 additional 525-sheet feeders

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for your printer model.

- Xerox®ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580supplies
- Xerox®ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880supplies

For details, see Printing the Configuration Page on page 25.
Information Pages

This section includes:

- Printing the Menu Map ..................................................................................................................................................... 24
- Viewing Information Pages ............................................................................................................................................. 24
- Printing the Configuration Page .................................................................................................................................... 25

Your printer has a printable set of information pages. These include configuration and font information and more. You can use information pages to view the status, performance, and options of the printer. You can access information pages at the control panel or in CentreWare Internet Services.

Note: You can use the menu map to view all of the available information pages that your printer provides.

Printing the Menu Map

The menu map is an information page that you can print from the printer control panel. It provides a hierarchical view of all of the menus that you can access for your printer.

To print the menu map:

1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK. The Menu Map is highlighted by default.
2. To print the Menu Map, press OK.

Viewing Information Pages

You can view the following information pages at the printer control panel:

<table>
<thead>
<tr>
<th>Information Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Page</td>
<td>The configuration page lists printer information such as default settings, installed options, network settings including IP address, and font settings. You can use this page for network analysis and general troubleshooting. For details, see Printing the Configuration Page on page 25.</td>
</tr>
<tr>
<td>Paper Tips Page</td>
<td>The Paper Tips page provides a list of supported paper and gives tips on how to set up and load paper trays. For details, see Supported Paper on page 46.</td>
</tr>
<tr>
<td>Supplies Usage Page</td>
<td>The Supplies Usage page provides coverage information and part numbers for reordering supplies. For details, see Printing the Supplies Usage Page on page 111.</td>
</tr>
<tr>
<td>Connection Setup Page</td>
<td>The Connection Setup Page provides details on how to connect your printer to a computer or network.</td>
</tr>
</tbody>
</table>
### Information Page

<table>
<thead>
<tr>
<th><strong>Information Page</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup Page</td>
<td>The Startup Page provides basic printer configuration and network information. If enabled, this page prints during the startup sequence or if the printer detects an error during the power-on self-test diagnostics.</td>
</tr>
<tr>
<td>Usage Profile</td>
<td>The usage profile page shows a summary of billing meter information, including page count, maintenance kit, and supply usage information. For details, see Printing the Usage Profile on page 111.</td>
</tr>
<tr>
<td>PostScript Font List</td>
<td>The PostScript Font List provides a printout of all PostScript fonts that are available on the printer or installed on the optional solid-state drive.</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>The PCL Font List provides a printout of all PCL fonts that are available on the printer or installed on the optional solid-state drive.</td>
</tr>
<tr>
<td>Disk Directory</td>
<td>The Disk Directory page provides a list of all downloaded files on the solid-state drive, such as fonts and macros. <strong>Note:</strong> To use this feature, you must have the optional solid-state drive installed.</td>
</tr>
</tbody>
</table>

To print an information page:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press **OK**.
2. Navigate to Information Pages, then press **OK**.
3. To print an information page, navigate to the desired page, then press **OK**.

### Printing the Configuration Page

The configuration page lists printer information such as default settings, installed options, network settings including IP address, and font settings.

To print the Configuration Page:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press **OK**.
2. Navigate to Information Pages, then press **OK**.
   The Configuration Page is highlighted by default.
3. To print the Configuration Page, press **OK**.
4. On the Configuration Page, under General Information, locate the current firmware version.
Sample Pages

You can use sample pages to demonstrate the quality of graphics, speed of continuous output, and color sample charts of the printer.

<table>
<thead>
<tr>
<th>Sample Page Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics Demonstration</td>
<td>This option prints a graphics-quality image.</td>
</tr>
<tr>
<td>Office Demonstration</td>
<td>This option prints an office-quality image.</td>
</tr>
<tr>
<td>2-Sided Demonstration</td>
<td>This option demonstrates printing on both sides of the paper.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option requires that the 2-sided printing option is installed.</td>
</tr>
<tr>
<td>Print Mode Demonstration</td>
<td>This option prints Office Demonstration pages in each of the four print-quality modes: Fast Color, Standard, Enhanced, and Photo. You can use this mode to demonstrate printer speed and resolution.</td>
</tr>
<tr>
<td>CMYK Sampler Pages</td>
<td>This selection prints a multi-page CMYK color sampler chart.</td>
</tr>
<tr>
<td>RGB Sampler Pages</td>
<td>This selection prints a multi-page RGB color sampler chart.</td>
</tr>
<tr>
<td>PANTONE Color Sampler Pages</td>
<td>This selection prints a multi-page PANTONE/256 color sampler chart.</td>
</tr>
</tbody>
</table>

1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press **OK**.
2. Navigate to Sample Pages, then press **OK**.
3. Navigate to the desired sample page, then press **OK**.
4. Select an option.
   - **Single Print:** This option prints a single-page sample print. To print, press **OK**.
   - **Continuous Print:** This option outputs the sample page repeatedly. To stop the print job, on the control panel, press the **Cancel** button.

**Note:** Continuous Print applies to the Graphics Demonstration, Office Demonstration, and 2-Sided Demonstration sample pages only.
# More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Installation Guide</em></td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td><em>Quick Use Guide</em></td>
<td>Packaged with the printer.</td>
</tr>
</tbody>
</table>
| **Other documentation for your printer**     | **• Xerox® ColorQube 8580 Color Printer:** www.xerox.com/office/CQ8580docs  
  **• Xerox® ColorQube 8880 Color Printer:** www.xerox.com/office/CQ8880docs |
| **Recommended Media List**                   | **United States:** www.xerox.com/printer-supplies/recommended-paper/enus 
  **European Union:** www.xerox.com/eurpaper |
| **Technical support information for your printer:** including online technical support, Online Support Assistant, and driver downloads. | **• Xerox® ColorQube 8580 Color Printer:** www.xerox.com/office/CQ8580support 
  **• Xerox® ColorQube 8880 Color Printer:** www.xerox.com/office/CQ8880support |
| **PhaserSMART Technical Support automatically diagnoses problems on your network printer and proposes solutions.** | www.phasersmart.com |
| **Information about menus or error messages** | Press the control panel Help (?) button.                                 |
| **Information Pages**                         | Print from the control panel or from CentreWare Internet Services.       |
| **CentreWare Internet Services documentation** | To access CentreWare Internet Services, open a Web browser, then type the IP address for your printer. 
  In CentreWare Internet Services, click Help. |
| **Order supplies for your printer**           | **• Xerox® ColorQube 8580 Color Printer:** www.xerox.com/office/CQ8580supplies 
  **• Xerox® ColorQube 8880 Color Printer:** www.xerox.com/office/CQ8880supplies |
| **A resource for tools and information, including interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs.** | www.xerox.com/office/businessresourcecenter |
| **Local sales and support center**            | www.xerox.com/office/worldcontacts |
| **Printer registration**                      | www.xerox.com/office/register |
| **Xerox® Direct online store**                | www.direct.xerox.com/ |
Xerox® Welcome Center

If you need assistance during or after printer installation, visit the Xerox® website for online solutions and support for your printer model:
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/worldcontacts
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/worldcontacts

If you require further assistance, contact the Xerox® Welcome Center for the United States and Canada at 1-800-835-6100.

If a local Xerox representative telephone number was provided during printer installation, record the telephone number in the following space.

#______________________________

If you need additional help using your printer:
1. Refer to this user guide.
2. Contact the system administrator.
3. Visit our customer website for your printer model:
   - Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
   - Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support

To assist you, the Welcome Center needs the following information:
- The nature of the problem.
- The serial number of the printer.
- The fault code.
- The name and location of your company.
This chapter includes:

- Installation and Setup Overview ................................................................. 30
- Selecting a Location for the Printer .............................................................. 31
- Modifying General Settings ........................................................................ 32
- Connecting the Printer ................................................................................ 34
- Configuring Network and Printer Settings .................................................. 36
- Installing the Software ................................................................................ 40

See also:

The System Administrator Guide for your printer model:
Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580docs
Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880docs

The Installation Guide is packaged with your printer.
Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected.

The following steps provide an overview of the connection and installation steps for your printer.
1. Select a location for your printer. For details, see Selecting a Location for the Printer on page 31.
2. Modify the printer settings as needed. For details, see Modifying General Settings on page 32.
3. Choose a connection method.
4. Connect your printer to your computer with a USB cable. For details, see Connecting to a Computer Using USB on page 35.
5. Connect your printer to a network with an Ethernet cable. For details, see Physically Connecting the Printer to the Network on page 35.
6. For a network-connected printer, configure the network settings. For details, see Configuring Network and Printer Settings on page 36.
7. You can install print driver software and utilities from the Software and Documentation disc. For details, see Installing the Software on page 40.
Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 10–80 %.  
   **Note:** Under extreme environmental conditions, such as 10°C and 85 % relative humidity, defects can occur due to condensation.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface.

3. After positioning the printer, you are ready to connect it to the power source and computer or network.

See also:

Clearance Requirements on page 172
Modifying General Settings

You can modify printer settings from the control panel such as the language, date and time, and units of measurement. You can also enable or prevent automatic Startup page printing when the printer is turned on.

Configuring General Setup Options

You can configure general setup options for your printer from the control panel.

To configure general setup options:
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Select an option.
   - **Control Panel Setup**: You can use this option to access settings such as Language and Control Panel Brightness.
   - **Printer Controls**: You can use this option to access settings such as the Startup Page, Date and Time, and Metric Defaults.
3. To configure a setting, navigate to the option that you want to change, then press OK.

To view all general setup options, print a menu map. For details, see Printing a Menu Map on page 24.

Setting the Date and Time

You can set the date and time at the control panel. The date and time stamp appears on various printed documents and reports.

To set the date and time:
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Printer Controls, then press OK.
3. Navigate to Date and Time, then press OK.
4. Select an option.
5. To increase or decrease the value for an option, use the arrows, then press OK.
6. When you are finished, navigate to Exit, then press OK.
Disabling the Startup Page

The Startup page provides basic printer configuration information, such as printer name, serial number, font, firmware, and Ethernet versions. The Startup page is configured to print each time you turn on your printer. If you do not want the Startup page to print, you can turn off the feature.

To disable the Startup page:
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Printer Controls, then press OK.
3. To disable the Startup page, press OK.

Modifying Power Settings

You can modify power usage settings for Power Saver or Fast Resume modes at the printer control panel.

Setting a Power Saver Mode

Your printer has power-saving modes that reduce energy consumption without shutting off the printer. You can set the Power Saver mode at the control panel.

Note: You cannot put the printer into Power Saver mode when the printer is processing a job, warming up, cleaning, or shutting down.

To specify the Power Saver mode:
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Printer Controls, then press OK.
3. Navigate to Warm-up Mode, then press OK.
4. Select an option.
   - Intelligent Ready causes the printer to wake and sleep based on previous usage patterns.
   - Job Activated causes the printer to wake when it detects activity.
   - Scheduled causes the printer to wake and sleep according to a schedule you specify.
5. Press OK.

Enabling Fast Resume Mode

Fast Resume mode overrides the default power saver timeouts and increases energy usage. To bring the printer out of power saving and standby modes more quickly, you can use Fast Resume.

To enable Fast Resume:
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Printer Controls, then press OK.
3. Navigate to Fast Resume, then press OK.
Connecting the Printer

This section includes:
• Printing the Connection Setup Page............................................................................................................................ 34
• Selecting a Connection Method ...................................................................................................................................... 34

Printing the Connection Setup Page

The Connection Setup Page provides details on how to connect your printer to a computer or network. The Connection Setup page prints automatically the first time that the printer is turned on.

To print the Connection Setup page manually:
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Connection Setup, then press OK.
3. To print the Connection Setup page, press OK.

Note: For details, see the Installation Guide that is packaged with your printer.

Selecting a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you select depends on how your computer is connected to the network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a network connection, it is important to understand how your computer is connected to the network. For details, see About TCP/IP and IP Addresses on page 36.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately.

• **Network**: If your computer is connected to an office network or home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer. It must be connected through a router or hub. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using CentreWare Internet Services.

• **USB**: If you connect the printer to one computer and do not have a network, use a USB connection. A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In addition, a USB connection does not provide access to CentreWare Internet Services.
Connecting to a Computer Using USB

To use USB, Windows XP SP3, Windows 7, Windows 8 or later, Windows Server 2003 or later, or Macintosh OS X version 10.7 or later are required.

To connect the printer:
1. Ensure that the printer is turned off.
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer.
3. Attach the power cord and then plug in the printer and turn it on.
4. Connect the A end of the USB cable to the USB Port on the computer.
5. When the Windows Found New Hardware Wizard appears, cancel it.
   You are ready to install the print drivers.

Physically Connecting the Printer to the Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is used for one or more computers and supports many printers and systems simultaneously. An Ethernet connection provides direct access to printer settings using CentreWare Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. Connect the other end of the Ethernet cable to a correctly configured network port on a hub or router.
3. Turn on the printer.
Configuring Network and Printer Settings

This section includes:

- About TCP/IP and IP Addresses .......................................................... 36
- Viewing the Automatically Assigned IP Address ........................................ 36
- Assigning a Static IPv4 Address Manually .............................................. 37
- Accessing CentreWare Internet Services .............................................. 38
- Using PhaserSMART Technical Support .............................................. 39

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically assigns an IP address to every computer and printer on the network that is configured to use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.

Viewing the Automatically Assigned IP Address

To install the print drivers for a network-connected printer, you need the IP address of your printer. You also need the IP address to access the settings of your printer through CentreWare Internet Services.

When your printer is connected to a network, it acquires an IP address using DHCP automatically.

To view the IP address on the control panel:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Printer Identification, then press OK.
3. To view the IP address, navigate to TCP/IPv4 Address or TCP/IPv6 Address.
Assigning a Static IPv4 Address Manually

By default, the printer is set to acquire an IP address from the network server using DHCP. Network addresses assigned by DHCP are temporary, however. After a specified time, the network could assign a new IP address to the printer. If the print driver is set to an IP address that changes periodically, you can experience connectivity issues. To avoid problems, or if your network administrator requires a static IP address for the printer, you can assign the IP address to the printer.

You can assign a static IP address to your printer from the printer control panel. Once an IP address is assigned, you can change it using CentreWare Internet Services.

To assign a static IP address to the printer, you need the following information:

- An IP address properly configured for your network
- The Network Mask address
- The default Router/Gateway address

If you are on a network managed by a network administrator, contact your network administrator to obtain the network information.

For a home network using routers or other devices to connect the printer to the network, refer to the device instructions on assigning network addresses. The router or device documentation can give you a range of acceptable address numbers you can use. It is important that the addresses be similar to the IP addresses used by other printers and computers on the network, but not the same. Only the last digit must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4.

The router could assign the static IP address of the printer to another computer that obtains its IP address dynamically. To avoid having the IP address reassigned, give the printer an address at the higher end of the range allowed by the router or device. For example, if your computer has IP address 192.168.1.2, and your device allows IP addresses to 192.168.1.25, select an address between 192.168.1.20 and 192.168.1.25.

In IPv6 network configurations, the IPv6 address is assigned automatically. For a protocol other than IPv4, refer to the System Administrator Guide. For details, see the Help in CentreWare Internet Services.

See also:
Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580docs
Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880docs
Assigning an IPv4 Address Manually

1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Connection Setup, then press OK.
3. Navigate to Network Setup, then press OK.
4. Navigate to TCIP/IPv4 Setup, then press OK.
5. Navigate to IPv4, then ensure that the setting is On.
6. Navigate to DHCP/BOOTP, then, to turn it off, press OK.
7. Navigate to AutoIP, then, to turn it off, press OK.
8. Navigate to IPv4 Address, then press OK.
9. To enter an IP address, use the arrows to select a number, then press OK. To complete the IP address, repeat this step for each number field.
10. When finished, press OK.

Note: If a message appears that indicates that the IP address already exists, enter a new address.

Resetting the TCP/IP Connection

1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Connection Setup, then press OK.
3. Navigate to Reset Connection Setup, then press OK.
4. To select Reset Connection Setup NOW, press OK.

Accessing CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to configure and administer the printer from a Web browser.

For details, see the System Administrator Guide for your printer model:
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580docs
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880docs

CentreWare Internet Services requires:
- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and CentreWare Internet Services enabled on the printer.
- A network-connected computer with a Web browser that supports JavaScript.

To access CentreWare Internet Services:
1. Ensure that the printer is connected and turned on.
2. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
Using PhaserSMART Technical Support

PhaserSMART is an automated, Internet-based system that uses your Web browser to send diagnostic information from your printer to the Xerox® website. PhaserSMART examines the information, diagnoses the problem, and proposes a solution.

To access PhaserSMART:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Select Support.
3. Click PhaserSMART Diagnostic Tool.
4. To accept the terms and access PhaserSMART, click I Accept.
Installing the Software

This section includes:

- **Before You Begin** ................................................................. 40
- **Operating System Requirements** .......................................... 40
- **Available Print Drivers** ............................................................. 40
- **Using Walk-Up Installation** .................................................. 41
- **Installing the Print Drivers** ................................................... 42

**Before You Begin**

Before you install the software for your printer, complete the following steps.

1. Ensure that the printer is connected and turned on.
   - If the printer is connected to a network, verify that it has a valid IP address.
   - If you are using USB, ensure that the printer is connected to your computer.

2. Review the operating system requirements for your computer.

3. Review the list of available print drivers.

**Operating System Requirements**

- Macintosh OS X version 10.7 and later.
- UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

**Available Print Drivers**

Xerox® provides print drivers for various page description languages and operating systems. You can use a Xerox® print driver to select printer features.

To install print drivers and utilities for your printer, you can use the *Software and Documentation disc*. To download the latest print drivers for your printer:

- Xerox® ColorQube 8580 Color Printer: [www.xerox.com/office/CQ8580drivers](http://www.xerox.com/office/CQ8580drivers)
- Xerox® ColorQube 8880 Color Printer: [www.xerox.com/office/CQ8880drivers](http://www.xerox.com/office/CQ8880drivers)
### Print Driver

<table>
<thead>
<tr>
<th>Print Driver</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows PostScript Driver</td>
<td>Software and Documentation disc and Web</td>
<td>The default print driver is PostScript. To take full advantage of the custom features of your printer, use the PostScript print driver.</td>
</tr>
<tr>
<td>Macintosh OS X version 10.7 and later.</td>
<td>Software and Documentation disc and Web</td>
<td>Install this print driver to enable printing from a Mac OS X version 10.7 or later operating system.</td>
</tr>
<tr>
<td>Windows PCL5c Driver</td>
<td>Software and Documentation disc and Web</td>
<td>You can use the Printer Command Language (PCL) print driver for applications that require PCL.</td>
</tr>
<tr>
<td>Xerox Global Print Driver (Windows)</td>
<td>Web only</td>
<td>The Global Print Driver uses bi-directional communication to discover the features for any supported Xerox printer. Once it discovers the features, then it configures itself to support those features.</td>
</tr>
<tr>
<td>Xerox Mobile Express Driver (Windows)</td>
<td>Web only</td>
<td>The Xerox® Mobile Express Driver works with any printer available to your computer that supports standard PostScript. It configures itself for the printer you select every time you print. If you travel frequently to the same sites, you can save your favorite printers in that location and the print driver saves your settings.</td>
</tr>
<tr>
<td>UNIX PostScript Driver</td>
<td>Web only</td>
<td>Install this print driver to enable printing from a UNIX or Linux operating system.</td>
</tr>
</tbody>
</table>

### Using Walk-Up Installation

The Walk-Up Installation feature enables the Software and Documentation disc Installer to locate your printer in the list of discovered printers in the installer window. If you do not have the printer IP address, you can use Walk-Up Installation to connect the printer to the installer.

To use Walk-Up Installation:

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
3. Select Walk-Up Technology, then click Next.
4. At the control panel, to select Walk-Up Features, press OK.
5. Use the arrows to navigate to Select for Installation, then press OK.
   The installer connects the computer to the printer, then completes the print driver installation. When installation completes, a confirmation page prints.
Installing the Print Drivers

This section includes:

- Installing Print Drivers for a Windows Printer ................................................................. 42
- Advanced Discovery of a Network Printer ............................................................................. 43
- Installing the Print Drivers for Macintosh .......................................................................... 43
- Installing the Print Drivers for UNIX and Linux ............................................................... 44
- Installing Alternate Drivers ............................................................................................... 44

To install print drivers and utilities for your printer, you can use the Software and Documentation disc. To download the latest print drivers for your printer:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580drivers
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880drivers

Installing Print Drivers for a Windows Printer

Notes:

- To install a print driver for a USB-connected printer, cancel the Windows hardware detection installer, then run the Software and Documentation disc that is provided with your printer.
- The default print driver is PostScript.

To install the print driver software:

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
3. To allow the program to make changes to your computer, if prompted, click Yes.
4. To change the language, click Language.
5. Select your language, then click OK.
6. Click Install Printer Driver.
7. To accept the license agreement, click I Agree.
8. From the list of discovered printers, select your printer, then click Next.
   If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is connected properly.
9. Accept the defaults, then click Install.
   - To install the optional Windows PCL5 print driver, select the corresponding check box.
   - To use the latest print driver, for Download Files From the Internet, select the check box.
10. To set the printer as your default printer, at the Installation Complete screen, for Set Printer as Default, select the check box.

Xerox® ColorQube 8580/8880 Color Printer
User Guide
11. To close the install window, click Finish.
12. Register your printer or click Close.
13. Select or clear the **Set Printer as Default** and **Print a Test Page** check boxes.

   *Note:* If your printer does not appear in the list of discovered printers, see **Advanced Discovery of a Network Printer** on page 43.

### Advanced Discovery of a Network Printer

1. If your printer does not appear in the list of discovered printers, click **Extended Search**.
2. If your printer still does not appear in the list of discovered printers, and you know the IP address:
   a. Click the **Network Printer** icon at the top of the window.
   b. Enter the IP address or the DNS name of the printer.
   c. Click **Search**.
3. From the list of discovered printers, select your printer, then click **Next**.
4. If the printer still does not appear in the list of discovered printers, and you do not know the IP address:
   a. Click **Advanced Search**.
   b. If you know the gateway address and subnet mask, click the top button and enter the addresses into the Gateway and Subnet Mask fields.
   c. If you know the address of another printer on the same subnet, click the middle button and enter the address in the IP Address field.
   d. From the list of discovered printers, select your printer, then click **Next**.

### Installing the Print Drivers for Macintosh

1. Insert the *Software and Documentation disc* into the appropriate drive on your computer.
2. Open Xerox® Print Drivers 3.xx.x.dmg/pkg as needed for your printer.
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.
4. When prompted, click **Continue**.
5. To accept the license agreement, click **I Agree**.
6. To accept the current installation location, click **Install**, or select another location for the installation files, then click **Install**.
7. If prompted, enter your password, then click **OK**.
8. From the list of discovered printers, select your printer, then click **Next**.
9. If your printer does not appear in the list of discovered printers:
   a. Click the **Network Printer Icon**.
   b. Type the IP address of your printer, then click **Continue**.
   c. Select your printer in the list of discovered printers, then click **Continue**.
10. If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is connected properly.
11. To accept the print queue message, click **OK**.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.

   Note: The printer is added automatically to the printer queue in Macintosh OS X versions 10.7 and later.

Installing the Print Drivers for UNIX and Linux

You must have root or superuser privileges to perform the UNIX print driver installation on your computer.

   Note: This procedure requires an Internet connection.

Before you begin:

Verify that the TCP/IP protocol is enabled and the network cable is installed.

To install the print driver software:
1. On the printer control panel, for the IP address, do one of the following:
   • Allow the printer to set up a DHCP address.
   • Enter the IP address manually.
2. At your computer, do the following:
   a. Go to www.xerox.com/office/CQ8580drivers or www.xerox.com/office/CQ8880drivers as appropriate, and select your printer model.
   b. From the Operating System drop-down menu, select the operating system for your server.
   c. Click Go.
   d. Select the appropriate package for your operating system.
   e. To begin downloading, click the Start button.
3. In the notes below the driver package that you selected, click the Installation Guide link, then follow the installation instructions.

Installing Alternate Drivers

   Note: This procedure requires an Internet connection.

To install the print driver software:
1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
3. To allow the program to make changes to your computer, if prompted, click Yes.
4. Click Alternative Drivers.
5. Locate the desired print driver in the list, then click the link.
6. To download and install the print driver, follow the instructions.
This chapter includes:

- **Supported Paper** ........................................................................................................................................................................ 46
- **Selecting Paper Options for Printing** ........................................................................................................................................ 51
- **Loading Paper** .................................................................................................................................................................................. 53
- **Printing Special Paper** .................................................................................................................................................................. 59
- **Using Custom Paper Sizes** .......................................................................................................................................................... 80
Supervised Paper

This section includes:

- Recommended Paper .......................................................................................................................................................... 46
- Ordering Paper ...................................................................................................................................................................... 47
- Paper That Can Damage Your Printer .............................................................................................................................................. 47
- Paper Storage Guidelines ........................................................................................................................................................... 47
- Paper Tips Page .......................................................................................................................................................................... 48
- Supported Paper Types and Weights .......................................................................................................................................................... 48
- Supported Standard Paper Sizes ......................................................................................................................................................... 49
- Supported Paper Types and Weights for Automatic 2-Sided Printing ........................................................................................................... 49
- Supported Paper Sizes for Automatic 2-Sided Printing ........................................................................................................................................... 49
- Supported Custom Paper Sizes ............................................................................................................................................................ 50
- Supported Envelope Sizes ................................................................................................................................................................. 50

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Paper

A list of paper and media recommended for your printer is available at:

North America
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/printer-supplies/recommended-paper/enus
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/printer-supplies/recommended-paper/enus

European Union
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/europaper
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/europaper

See also:
- Paper Tips Page on page 48
- Supported Paper Types and Weights on page 48
Ordering Paper

Order supplies from your local reseller or go to:
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580supplies
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880supplies

**CAUTION:** The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

See also:
Ordering Supplies on page 119

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Plastic media other than supported transparencies
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media
- Iron on transfer paper

**CAUTION:** The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Contact your Xerox representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.
- Reduce the exposure of paper to strong lights for long periods of time.
- Maintain constant temperatures and relative humidity.
- Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
- Store paper flat, either on pallets, cartons, shelves, or in cabinets.
Avoid food or drinks in the area where paper is stored or handled.
Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.
Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are ready to use it. Keep unused media in the bag and reseal it for protection.

**Paper Tips Page**

You can print a Paper Tips page that provides a list of all supported paper types and sizes for each paper tray. The Paper Tips page also provides details about 1-sided or 2-sided printing options that are available for various paper and media types.

To print the Paper Tips page:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Information Pages, then press OK.
3. To print the Paper Tips page, navigate to it, then press OK.

**Supported Paper Types and Weights**

<table>
<thead>
<tr>
<th>Paper Tray</th>
<th>Paper Type</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Trays</td>
<td>Plain</td>
<td>60–120 g/m²</td>
</tr>
<tr>
<td></td>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pre-Printed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pre-punched</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Colored Paper</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lightweight</td>
<td>60–74 g/m²</td>
</tr>
<tr>
<td></td>
<td>Lightweight Cardstock</td>
<td>100–120 g/m²</td>
</tr>
<tr>
<td></td>
<td>Cardstock</td>
<td>121–220 g/m²</td>
</tr>
<tr>
<td></td>
<td>Envelopes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Labels</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Glossy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transparency</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Index Cards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom Sizes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Postcard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tri-fold Brochures</td>
<td></td>
</tr>
<tr>
<td>Tray 1</td>
<td>Index Cards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom Sizes</td>
<td></td>
</tr>
</tbody>
</table>
Supported Standard Paper Sizes

<table>
<thead>
<tr>
<th>Paper Tray</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
</table>
| Tray 1     | A4 (210 x 297 mm, 8.3 x 11.7 in.)  
A5 (148 x 210 mm, 5.8 x 8.3 in.)  
A6 (105 x 148 mm, 4.1 x 5.8 in.)  
B5 (176 x 250 mm, 6.9 x 9.8 in.)  
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) | Letter (216 x 279 mm, 8.5 x 11 in.)  
Legal (216 x 356 mm, 8.5 x 14 in.)  
Index Cards (76 x 127 mm, 3 x 5 in.)  
Executive (184 x 267 mm, 7.25 x 10.5 in.)  
Statement (140 x 216 mm, 5.5 x 8.5 in.)  
Folio (216 x 330 mm, 8.5 x 13 in.) |
| Trays 2–5  | A4 (210 x 297 mm, 8.3 x 11.7 in.)  
A5 (148 x 210 mm, 5.8 x 8.3 in.)  
B5 (176 x 250 mm, 6.9 x 9.8 in.)  
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) | Letter (216 x 279 mm, 8.5 x 11 in.)  
Legal (216 x 356 mm, 8.5 x 14 in.)  
Executive (184 x 267 mm, 7.25 x 10.5 in.)  
Statement (140 x 216 mm, 5.5 x 8.5 in.)  
Folio (216 x 330 mm, 8.5 x 13 in.) |

Supported Paper Types and Weights for Automatic 2-Sided Printing

Automatic 2-sided printing is available for some printer models. If your printer is not configured with 2-sided printing, you can order this feature as an upgrade. For details, see Options and Upgrades on page 23.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>60–120 g/m²</td>
</tr>
<tr>
<td>Lightweight</td>
<td>60–74 g/m²</td>
</tr>
<tr>
<td>Letterhead</td>
<td>60–120 g/m²</td>
</tr>
<tr>
<td>Pre-Printed</td>
<td>60–120 g/m²</td>
</tr>
<tr>
<td>Pre-punched</td>
<td>60–120 g/m²</td>
</tr>
<tr>
<td>Colored Paper</td>
<td>60–120 g/m²</td>
</tr>
<tr>
<td>Lightweight Cardstock</td>
<td>100–120 g/m²</td>
</tr>
</tbody>
</table>

Supported Paper Sizes for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>JIS B5 (182 x 257 mm, 7.2 x 10.1 in.)</td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
<tr>
<td>B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Folio (216 x 330 mm, 8.5 x 13 in.)</td>
</tr>
<tr>
<td></td>
<td>Statement (140 x 216 mm, 5.5 x 8.5 in.)</td>
</tr>
</tbody>
</table>
In addition to the standard sizes, you can use the following custom-size paper for automatic 2-sided printing.

- Minimum print size: 139.7 x 210 mm (5.5 x 8.3 in.)
- Maximum print size: 216 x 356 mm (8.5 x 14 in.)

**Supported Custom Paper Sizes**

<table>
<thead>
<tr>
<th>Tray</th>
<th>Paper Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Minimum: 76 x 127 mm, 3 x 5 in.</td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm, 8.5 x 14 in.</td>
</tr>
</tbody>
</table>

*Note:* Print custom-size paper from Tray 1 only.

**Supported Envelope Sizes**

<table>
<thead>
<tr>
<th>Paper Tray</th>
<th>Envelope Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>DL envelope (110 x 220 mm, 4.33 x 8.66 in.)</td>
</tr>
<tr>
<td></td>
<td>No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)</td>
</tr>
<tr>
<td></td>
<td>C5 envelope (162 x 229 mm, 6.4 x 9 in.)</td>
</tr>
<tr>
<td></td>
<td>C6 envelope (114 x 162 mm, 4.5 x 6.38 in.)</td>
</tr>
<tr>
<td></td>
<td>No. 5½ envelope (111 x 146 mm, 4.4 x 5.75 in.)</td>
</tr>
<tr>
<td></td>
<td>Envelope 6 x 9 (152 x 228 mm, 6 x 9 in.)</td>
</tr>
<tr>
<td></td>
<td>No. 6¼ envelope (92 x 165 mm, 3.6 x 6.5 in.)</td>
</tr>
<tr>
<td></td>
<td>A7 envelope (133 x 184 mm, 5.25 x 7.25 in.)</td>
</tr>
<tr>
<td></td>
<td>Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>Choukei 3 envelope (120 x 235 mm, 4.72 x 9.25 in.)</td>
</tr>
<tr>
<td></td>
<td>Choukei 4 envelope (90 x 205 mm, 3.54 x 8.07 in.)</td>
</tr>
<tr>
<td>Trays 2–5</td>
<td>DL envelope (110 x 220 mm, 4.33 x 8.66 in.)</td>
</tr>
<tr>
<td></td>
<td>No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)</td>
</tr>
<tr>
<td></td>
<td>C5 envelope (162 x 229 mm, 6.4 x 9 in.)</td>
</tr>
<tr>
<td></td>
<td>C6 envelope (114 x 162 mm, 4.5 x 6.38 in.)</td>
</tr>
</tbody>
</table>
Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the desired paper.

Setting the Tray 1 Mode

Tray 1 mode specifies how the printer determines paper size and type when paper is loaded into Tray 1 but not specified at the printer control panel.

<table>
<thead>
<tr>
<th>Tray Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>The current paper type and size are in effect until you change them at the printer control panel.</td>
</tr>
<tr>
<td>Dynamic</td>
<td>The first print job that uses tray 1 after paper is loaded sets the paper size and type. You can override the settings at the printer control panel.</td>
</tr>
<tr>
<td>Automatic</td>
<td>The incoming job prints from tray 1 automatically when paper is in tray 1 and no other tray is specified.</td>
</tr>
<tr>
<td>Permanent</td>
<td>The printer changes the paper size and type only when you modify the settings at the printer control panel.</td>
</tr>
</tbody>
</table>

To set the Tray 1 mode:
1. At the printer control panel, use the arrows to navigate to Paper Tray Setup, then press OK.
2. Navigate to Tray 1 Mode, then press OK.
3. Navigate to the desired mode, then press OK.

Setting the Tray 2 Mode

Tray 2 mode specifies how the printer determines paper size and type when paper is loaded into Tray 2 and any additional 525-sheet feeder trays, but not specified at the printer control panel. Dynamic is the default setting for Tray 2 mode. You can override Tray 2 mode at the printer control panel when you load paper into the 525-sheet feeder trays.

Notes:
- For multiple 525-sheet feeders, the control panel displays a number for each additional tray. For tray 3, the control panel displays Tray 2-3 Mode.
- You can add additional 525-sheet feeder trays. For details, see Options and Upgrades on page 23.
To set the Tray 2 mode:
1. At the printer control panel, use the arrows to navigate to Paper Tray Setup, then press **OK**.
2. Navigate to Tray 2 Mode, then press **OK**.
3. Navigate to the desired mode, then press **OK**.

<table>
<thead>
<tr>
<th>Tray Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>The current paper type and size are in effect until you change them at the printer control panel.</td>
</tr>
<tr>
<td>Dynamic</td>
<td>The first print job that uses tray 1 after paper is loaded sets the paper size and type.</td>
</tr>
<tr>
<td>Permanent</td>
<td>The printer changes the paper size and type only when you modify the settings at the printer control panel.</td>
</tr>
</tbody>
</table>
Loading Paper

This section includes:

- General Paper Loading Guidelines ......................................................................................................................... 53
- Loading Paper in Tray 1 ........................................................................................................................................... 54
- Loading Paper in Trays 2-5 ......................................................................................................................................... 56
- Loading Paper for Automatic 2-Sided Printing ....................................................................................................... 58

General Paper Loading Guidelines

When you load paper and media in the trays, follow these guidelines.

- Fan paper before loading it in the paper tray.
- Do not overfill the paper trays. Do not load paper above the maximum fill line. Overfilling can cause paper jams.
- Adjust the paper guides to fit the paper size.
- Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
- Do not print on label media once a label has been removed from a sheet.
- Use only paper envelopes. Print envelopes 1-sided only.
- Do not use this printer to print CD labels.
- If excessive jams occur, use paper or other approved media from a new package.
Loading Paper in Tray 1

Tray 1 supports the widest variety of paper types. It is intended for small quantity jobs and jobs using special media. The tray extension provides support for larger paper.

To load paper:
1. To open tray 1, pull the handle out and down.
2. Open the tray extension by rotating it outward.
3. Fan paper before loading it in the paper tray.
4. Insert the paper with the short edge first.

5. Adjust the width guides until they touch the edges of the paper.

6. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. To use the current paper size and type, at the printer control panel prompt, press **OK**.

See also:
* Printing on Special Paper on page 59
* Using Custom Paper Sizes on page 80
Loading Paper in Trays 2-5

Trays 2-5 can accommodate up to 525 sheets of plain paper.

The printer uses the position of the paper tray guides to detect the size of the paper. Some settings require that the paper in the tray matches the size and type selected on the control panel.

To load paper:
1. Remove the tray from the printer.

2. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.
3. Fan paper before loading it in the paper tray.

4. Load paper into the tray.

⚠ **CAUTION:** There are separate fill lines inside of the tray for different types of paper and media. Do not load the tray above the appropriate fill line. Overloading the tray can cause the printer to jam.

5. Adjust the width guides until they touch the edges of the paper. When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.
6. Slide the tray back into the printer.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

**Loading Paper for Automatic 2-Sided Printing**

- For automatic 2-sided printing from tray 1, load paper face up with the top of the page toward the front of the printer.

- For automatic 2-sided printing from trays 2–5, load the paper face down with the top of the page toward the back of the printer.
Printing Special Paper

This section includes:

- Envelopes ................................................................................................................................................................................. 59
- Labels .................................................................................................................................................................................... 63
- Glossy ........................................................................................................................................................................................ 68
- Transparencies ...................................................................................................................................................................... 72
- Pre-Punched Paper .............................................................................................................................................................. 76

Envelopes

Guidelines for Printing Envelopes

- You can print envelopes from any tray that supports the size and type of envelope that you are using.
- Print quality depends on the quality and construction of the envelopes. Try another envelope brand if you do not get desired results.
- Maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of them.
- In the print driver software, select Envelope as the paper type.
- Do not use padded envelopes. Use envelopes that lie flat on a surface.
- Do not use envelopes with heat activated glue.
- Do not use envelopes with press and seal flaps.
- Do not use envelopes with windows, metal clasps, side seams, or adhesives with release strips.
- Use envelopes with diagonal seams, not side seams.
Printing Envelopes from Tray 1

1. To open tray 1, pull the handle out and down.

2. Open the tray extension by rotating it outward.
3. Insert up to 10 envelopes in the tray, align the stack, then adjust the guides until they are touching the edges of the stack.
   – Load side flap envelopes with the flaps closed, facing up, and aligned to the right of the tray.
   – Load end flap envelopes with the flaps closed, flaps up, and flaps on the leading edge, going into the printer.

4. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
   Note: Before you print your job, ensure that you select Envelope for paper type and select the envelope size in the print driver.
Printing Envelopes from Trays 2-5

1. Remove the tray from the printer.

2. Remove all paper from the tray.

3. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.

4. To load envelopes with long edge flaps, place the envelopes with the short edge going into the printer, flaps down and to the right. Do not load more than 40 envelopes.
5. Adjust the length and width guides.

Notes:

• Do not load envelopes above the bottom fill line. Overfilling the tray can cause the printer to jam.
• When the paper guides are adjusted correctly, a small space between the envelopes and the guides is normal.

6. Slide the tray back into the printer.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: Before you print your job, ensure that you select Envelope for paper type and select the envelope size in the print driver.

Labels

Guidelines for Printing Labels

• You can print labels from any tray.
• Print only on one side of the sheet of labels.
• Do not feed a sheet of labels through the printer more than once.
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
• Do not store labels in conditions of extreme heat or humidity. Storing them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
• Do not use vinyl labels.
• Do not use dry gum labels.
• Use full sheet labels only.

⚠️ CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could damage the printer.

**Printing Labels from Tray 1**

1. To open tray 1, pull the handle out and down.

2. Open the tray extension by rotating it outward.
3. Load labels face down with the top of the sheet feeding into the printer. Do not load more than 50 labels into tray 1.

4. Adjust the width guides until they touch the edges of the paper.

5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.  
   **Note:** Before you print your job, ensure that you select Labels for paper type in the print driver.
Printing Labels from Trays 2-5

1. Remove the tray from the printer.

2. Remove all paper from the tray.

3. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.

4. Load labels face up with the top edge toward the front of the tray. Do not load more than 400 sheets of labels into the tray.
5. Adjust the length and width guides.

>Note: When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.

6. Slide the tray back into the printer.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

>Note: Before you print your job, ensure that you select Labels for paper type in the print driver or that you select the corresponding tray as the paper source.
Glossy

This section includes:
- Guidelines for Printing on Glossy Paper .............................................................................................................. 68
- Printing Glossy Paper from Tray 1 ......................................................................................................................... 69
- Printing Glossy Paper from Trays 2-5 ....................................................................................................................... 70

Guidelines for Printing on Glossy Paper
- You can print glossy paper from any tray.
- Do not open sealed packages of glossy paper until you are ready to load them into the printer.
- Until you are ready to print, leave glossy paper in the original wrapper, and leave the packages in the shipping carton.
- Before loading glossy paper, remove all other paper from the tray.
- Load only the amount of glossy paper that you plan to use. Remove any remaining glossy paper from the tray when you are finished printing. Store unused paper in the original wrapper and seal.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy paper to curl and jam in the printer.
Printing Glossy Paper from Tray 1

1. To open tray 1, pull the handle out and down.

2. Open the tray extension by rotating it outward.

3. Load paper into the tray. Do not load more than 50 sheets of glossy paper in tray 1.
4. Adjust the width guides until they touch the edges of the paper.

5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
   Note: Before you print your job, ensure that you select Glossy Paper for paper type in the print driver.

Printing Glossy Paper from Trays 2-5
1. Remove the tray from the printer.

2. Remove all paper from the tray.

3. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.
4. Load paper into the tray. Do not load more than 400 sheets of glossy paper into the tray.

5. Adjust the paper guides to fit the paper size.

   **Note:** When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.

6. Slide the tray back into the printer.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

   **Note:** Before you print your job, ensure that you select Glossy Paper for paper type in the print driver, or that you select the corresponding tray as the paper source.
Transparencies

Guidelines for Printing Transparencies

You can print transparencies from any paper tray. You can print Transparencies on one side only.

⚠️ **CAUTION:** The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

- Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
- Remove all paper before loading transparencies in the tray.
- Do not load more than 50 transparencies in tray 1. Do not load more than 400 transparencies in trays 2–5. Overfilling the tray can cause the printer to jam.
- Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print quality.
- After loading transparencies, change the paper type to Transparency on the printer control panel.
- In the print driver software, select Transparency as the paper type.
- Do not fan transparencies.
Printing Transparencies from Tray 1

1. To open tray 1, pull the handle out and down.

2. Open the tray extension by rotating it outward.

3. Load transparencies into the tray. Do not load more than 50 transparencies in tray 1.
   
   Note: Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
4. Adjust the width guides until they touch the edges of the paper.
5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
   
   **Note:** Before you print your job, ensure that you select Transparency for paper type in the print driver.

**Printing Transparencies from Trays 2-5**

1. Remove the tray from the printer.

2. Remove all paper from the tray.

3. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.
4. Load transparencies into the tray. Do not load more than 400 transparencies in trays 2–5.
   
   Note: Only use transparencies that are recommended for solid ink printers.

Note: Do not load transparencies above the paper fill line inside the tray.

5. Adjust the length and width guides.
   
   Note: When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.
6. Slide the tray back into the printer.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
   
   **Note:** Before you print your job, ensure that you select Transparency for paper type in the print driver or select the corresponding tray as the paper source.

---

**Pre-Punched Paper**

**About Printing on Pre-Punched Paper**

You can print on long-edge pre-punched or hole-punched paper from any tray. Pre-punched paper requires that paper is loaded correctly and the correct paper type is selected. Printing over holes on pre-punched paper transfers ink to subsequent pages.
Printing Pre-Punched Paper from Tray 1

1. To open tray 1, pull the handle out and down.

2. Open the tray extension by rotating it outward.

3. Load pre-punched paper face down with holes aligned to the right side of the tray.
4. Within your application, adjust print margins to accommodate pre-punched paper. A minimum margin of 19 mm (0.75 in.) is recommended.

5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.  
   **Note:** Before you print your job, ensure that you select pre-punched for paper type in the print driver.

**Printing Pre-Punched Paper from Trays 2-5**

1. Remove the tray from the printer.

2. Remove all paper from the tray.

3. Move the length and width guides out:
   a. Pinch the guide lever on each guide.
   b. Slide the guides outward until they stop.
   c. Release the levers.

4. Load pre-punched paper face down with holes aligned to the right side of the tray.

   **Note:** When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.
5. Within your application, adjust print margins to accommodate pre-punched paper. A minimum margin of 19 mm (0.75 in.) is recommended.
6. Slide the tray back into the printer.
7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
8. Before you print your job, ensure that you select pre-punched for paper type in the print driver or that you select the corresponding paper tray as the paper source.
Using Custom Paper Sizes

Creating Custom Paper Sizes at the Control Panel

Your printer can store up to five custom paper sizes that you create at the printer control panel. Custom sizes appear in the order of frequency of use. When you select a custom size, it goes to the top of the list. When you enter a new custom paper size, it replaces the least-used size.

To create a custom paper size:
1. Load the custom-size paper in the tray.
2. At the control panel, when prompted, use the arrows to navigate to Change Setup, then press OK.
3. Navigate to New Custom Size, then press OK.
4. For Long Edge and Short Edge, do one of the following actions.
   - To accept the current selection, press OK.
   - To enter a new size, navigate to Change, then press OK. To specify a size, use the arrows, then press OK.
5. Navigate to the desired paper type, then press OK.

See also:
Loading Paper on page 53

Creating Custom Paper Sizes in the Print Driver

You can print custom-size paper from Tray 1 only. Custom-size paper settings are saved in the print driver and are available for you to select in all your applications. For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?)..

See also:
Supported Paper on page 46
This chapter includes:

- **Printing Overview** ................................................................. 82
- **Selecting Printing Options** ......................................................... 83
- **Printing Features** ...................................................................... 88
- **Printing Special Job Types** ....................................................... 95
Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected to an active network. Make sure that you have the correct print driver software installed on your computer. For details, see Installing the Software on page 40.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.
3. Access the print settings in your software application. For most software applications, press CTRL+P for Windows, or CMD+P for Macintosh.
4. Select your printer.
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® Features for Macintosh. The title of the button can vary depending on your application.
6. Modify the print driver settings as necessary, then click OK.
7. Click Print to send the job to the printer.

See also:
Loading Paper on page 53
Selecting Printing Options on page 83
Printing on Both Sides of the Paper on page 89
Printing on Special Paper on page 59
Selecting Printing Options

This section includes:

- Windows Printing Options ................................................................. 84
- Macintosh Printing Options ............................................................... 85
- Using Earth Smart Settings ................................................................. 86
- Selecting a Print-Quality Mode ............................................................ 86

Printing options include settings for paper size and type, 2-sided printing, page layout, and print quality.

For Windows, you can set printing options in the software application or in the Windows printer preferences.

- Printing options that are set in the software application are temporary and specific to each print job. When the application closes, the settings are lost.
- Printing options that are set in Windows printer preferences become the default settings for all print jobs.

For Macintosh, you can set printing options only in the software application.
Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the Printing Preferences window. You can specify your most common printing options and save them so that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing Preferences.

To select default printing options:
1. Navigate to the list of printers on your computer:
   - For Windows XP SP3, click Start>Settings>Printers and Faxes.
   - For Windows Vista, click Start>Control Panel>Hardware and Sound>Printers.
   - For Windows Server 2003 and later, click Start>Settings>Printers.
   - For Windows 7, click Start>Devices and Printers.
   - For Windows 8, click Control Panel>Devices and Printers.

   Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then select Personalize>Control Panel Home>Devices and Printers.

2. In the list, right-click the icon for your printer and click Printing Preferences.
3. In the Printing Preferences window, click a tab, select the options, then click OK to save.

   Note: For more information about Windows print driver options, click the Help button (?) in the Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job to the printer.

1. In your software application, access the print settings. For most software applications, click File>Print or press CTRL+P
2. Select your printer, then click Properties to open the print driver dialog box.
3. Select your printer, then to open the print driver dialog box, click Printer Properties. Depending on your application, the title of the button varies.
4. To set your preferred printing options, in the print driver, click any tab and make selections.
5. To save your settings and exit the print driver, click OK.
6. To send the job to the printer, click Print.
**Saving a Set of Commonly Used Printing Options for Windows**

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. In your software application, access the print settings. For most software applications, click **File>Print** or press **CTRL+P**.
2. Select your printer, then click **Properties** to open the print driver dialog box. Depending on your application, the title of the button varies.
3. To set your preferred printing options, in the print driver, click any tab and make selections.
4. At the bottom of the **Printing Properties** window, click **Saved Settings**, then click **Save As**.
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, then click **OK**.
6. To print using these options, select the name from the list.

**Selecting Job Completion Notification for Windows**

You can select to be notified when your job finishes printing. A message appears on your computer screen with the name of the job and the name of the printer where it was printed.

To select job completion notification before printing:
1. In your software application, access the print settings. For most software applications, click **File>Print** or press **CTRL+P**.
2. Select your printer, then click **Properties** to open the print driver dialog box. Depending on your application, the title of the button varies.
3. In the Advanced tab, double-click **Notification**.
4. Click **Notify for Completed Jobs**.
5. Select an option:
   - **Enabled**: This option turns on notifications.
   - **Disabled**: This option turns off the Notification feature.
6. To save the settings, click **OK**.

**Macintosh Printing Options**

**Selecting Printing Options for Macintosh**

To use specific printing options, change the settings before sending the job to the printer.

1. In your software application, access the print settings. For most software applications, click **File>Print** or press **CTRL+P**.
2. Select your printer.
3. For **Copies & Pages**, select **Xerox® Features**.
4. To set your preferred printing options, click the menus, then select desired options.
5. To view all options for Xerox Features, click **Paper/Output**.
6. To send the job to the printer, click **Print**.
**Saving a Set of Commonly Used Printing Options for Macintosh**

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. In your software application, access the print settings. For most software applications, click **File>Print** or press **CTRL+P**
2. Select your printer.
3. For Copies & Pages, select **Xerox® Features**.
4. To view all options for Xerox Features, click **Paper/Output**.
5. Select your commonly used printing options.
6. Click **Presets>Save current setting as preset**.
7. To save the set of options in the Presets list, type a name for the preset, then click **OK**.
8. To print using these options, select the name from the list.

**Using Earth Smart Settings**

Earth Smart settings allow you to reduce environmental pollution while printing by reducing the use of materials and energy. You can select Earth Smart Settings as the default for all of your print jobs.

For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?).

**Selecting a Print-Quality Mode**

You can set print-quality modes at the printer control panel, from the software application, or from CentreWare Internet Services.

**PostScript Print-Quality Modes**

<table>
<thead>
<tr>
<th>Print-Quality Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Color</td>
<td>Fast Color rapidly produces review documents for rush jobs. You can use this mode when you have many images or for previewing your work. This option is not recommended for documents containing small text, fine detail, or large areas of bright, solid fill.</td>
</tr>
<tr>
<td>Standard</td>
<td>Standard is a general-purpose print-quality mode. This mode produces crisp, bright prints at high speed and is recommended for vibrant, saturated color prints.</td>
</tr>
</tbody>
</table>
## Print-Quality Mode

<table>
<thead>
<tr>
<th>Print-Quality Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced</td>
<td>Enhanced is the best print-quality mode for business presentations. This mode produces superior text resolution and smooth light colors. Enhanced mode takes longer to process and print than Standard or Fast Color. The default mode is Enhanced.</td>
</tr>
<tr>
<td>Photo</td>
<td>Photo is the highest print-quality mode for color prints and provides the best detail and smoothness for photo images. This mode produces the highest-quality color prints, with the best text resolution and smoothest light colors. Photo mode takes longer to process and print than other print-quality modes.</td>
</tr>
</tbody>
</table>

### Setting the PostScript Print-Quality Mode

1. At the printer control panel, use the arrows to navigate to Printer Setup, then press **OK**.
2. Navigate to PostScript Setup, then press **OK**.
3. Navigate to Print-Quality Mode, then press **OK**.
4. Select the desired mode, then press **OK**.

## PCL Print-Quality Modes

<table>
<thead>
<tr>
<th>Print-Quality Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCL Standard Mode</td>
<td>PCL Standard mode is the general-purpose print-quality mode for full-speed printing. The default setting is Standard.</td>
</tr>
<tr>
<td>PCL Enhanced Mode</td>
<td>PCL Enhanced is the best print-quality mode for presentations. This mode produces superior text resolution and vibrant, saturated color prints.</td>
</tr>
</tbody>
</table>

### Setting the PCL Print-Quality Mode

1. At the printer control panel, use the arrows to navigate to Printer Setup, then press **OK**.
2. Navigate to PCL Setup, then press **OK**.
3. To set enhanced print-quality, navigate to Enhanced Mode, then press **OK**.
Printing Features

This section includes:

- Selecting Paper Options for Printing ................................................................. 88
- Page Orientation ........................................................................................................ 88
- Printing on Both Sides of the Paper ........................................................................ 89
- Printing Multiple Pages to a Single Sheet ............................................................ 90
- Printing Booklets .................................................................................................... 90
- Image and Color Options ....................................................................................... 91
- Printing Cover Pages ............................................................................................. 92
- Printing Separator Pages ...................................................................................... 92
- Scaling Options ...................................................................................................... 93
- Printing Watermarks .............................................................................................. 93
- Printing Mirror Images ......................................................................................... 94

Note: Not all options listed are supported on all printers. Some options apply only to specific printer models or configurations.

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the desired paper.

Page Orientation

Orientation allows you to select the direction that the page prints.

- **Portrait**: Orient the paper so that the text and images print across the short dimension of the paper.

  ![Portrait](image)

- **Landscape**: Orient the paper so that the text and images print across the long dimension of the paper.

  ![Landscape](image)

- **Rotated Landscape**: Orient the paper so that the content is rotated 180 degrees and with the long bottom side up.

  ![Rotated Landscape](image)
Printing on Both Sides of the Paper

This section includes:

- Automatic 2-Sided Printing ................................................................. 89
- Using Manual Feed ................................................................................... 89
- Manual 2-Sided Printing ......................................................................... 90

Your printer supports manual 2-sided printing. Use 2-Sided Printing to specify the page orientation for the printed output.

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings override the application page orientation settings.

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Portrait 2-Sided Print" /></td>
<td><img src="image2" alt="Portrait 2-Sided Print, Flip on Short Edge" /></td>
</tr>
<tr>
<td><img src="image3" alt="Landscape 2-Sided Print" /></td>
<td><img src="image4" alt="Landscape 2-Sided Print, Flip on Short Edge" /></td>
</tr>
</tbody>
</table>

**Automatic 2-Sided Printing**

Automatic 2-sided printing uses less paper and saves printer resources. Some paper sizes, types, and weights are not suitable for automatic 2-sided printing. If your printer is configured with automatic 2-sided printing, then automatic 2-sided printing is set as the default. If your printer is not configured with 2-sided printing, you can order this feature as an upgrade.

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings for portrait or landscape orientation from the application for printing the document. For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?).

See also:

- Supported Paper Types and Weights for Automatic 2-Sided Printing on page 49
- Supported Paper Sizes for Automatic 2-Sided Printing on page 49

**Using Manual Feed**

Tray 1 is the manual feed tray. Before you print the job, ensure that you load the correct paper in the tray.
Manual 2-Sided Printing

Tray 1 is the manual feed tray. Before you print the job, ensure that you load the correct paper in the tray. To print on pre-printed paper manually, in the print driver, select **2-Side**.

For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?).

Printing Multiple Pages to a Single Sheet

When printing a multiple-page document, you can print more than one page on each side of a sheet of paper. You can use the Pages Per Sheet setting to print 1, 2, 4, 6, 9, or 16 pages per side.

![Diagram of 4 pages on a single sheet](image)

For Windows, to set options for printing multiple pages on each side of a sheet of paper, in the print driver, click **Document Options > Page Layout > Pages per Sheet**.

For Macintosh, to set options for printing multiple pages on each side of a sheet of paper, in the print driver, in Copies & Pages, select **Layout > Pages per Sheet**.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any paper size that is supported for 2-sided printing. The driver automatically reduces each page image and prints four page images per sheet of paper, two page images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.

- **Gutter**: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).
- **Creep**: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can select a value from zero to 1 point.
The following booklet options are available in some print drivers.
- **Page Borders**: You can choose to print a border around each page image.
- **Booklet Paper Size**: You can specify the size of the paper for the booklet.
- **Reading Order**: You can print the pages in the booklet in reverse order.

**Image and Color Options**

The Image Options control the way the printer uses color to produce your document. The Windows PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each system has standard modes of color control for normal use and custom color options for the more advanced users. Image Options are on the Image Options tab of the Properties window. There, they are divided into Color Correction, Color By Words, and Color Adjustments tabs. For details on accessing the Properties window, see Printing Overview on page 82.

**Color Correction**

The Color Correction tab provides standard color modes.
- **Xerox Black and White**: This feature converts all color in the document to black and white or shades of gray.
- **Xerox Automatic Color**: This feature applies the best color correction to text, graphics, and images.
- **Custom Automatic Color**: This feature provides a selection of image simulations to match your document color.
Color By Words

The Color By Words tab provides a three-step process for defining custom color correction. By making a selection from each of the three fields, you create a sentence for controlling the color characteristics of the document. You can create several sentences to more precisely control the color content of the document. As you create a Color By Words sentence, it appears in the window below the selection fields. There are three parts to the sentence structure.

- **What Color to Change?:** Provides a list to select a color or range of colors to adjust, such as All Foliage-Green Colors.
- **How Much Change?:** Lets you select how much effect to make to the selected color.
- **What Type of Change?:** Lets you select the type of change, such as Vivid, from a list.

Color Adjustments

The Color Adjustments tab provides a set of six sliders for adjusting the individual components of the selected colors. You can use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and yellow components of the color.

Printing Cover Pages

A cover is the first or last page of a document. You can select paper sources for the covers that are different from the source used for the body of a document. For example, you can use your company letterhead for the first page of a document. You can also use heavyweight paper for the first and last pages of a report. You can use any applicable paper tray as the source for printing covers.

Printing Separator Pages

Separators allow you to add a blank sheet of paper between copies, individual pages, or the print job itself. In the print driver, you can specify where the separator page is inserted in your print job.

For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?).
Scaling Options

Scaling enlarges or reduces a page image to match a selected output paper size. You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%.

<table>
<thead>
<tr>
<th>50%</th>
<th>100%</th>
<th>200%</th>
</tr>
</thead>
<tbody>
<tr>
<td>![50% Image]</td>
<td>![100% Image]</td>
<td>![200% Image]</td>
</tr>
</tbody>
</table>

For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?).

Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

Notes:

- Not all options listed are supported on all printers. Some options apply only to a specific printer model, configuration, operating system, or driver type.
- Watermarks are not supported for some print drivers when booklet is selected or when more than one page is printed on a sheet of paper.
Using the watermark options, you can do the following:

- Create a watermark or edit an existing watermark using the Watermark Editor:
  - A Text Watermark uses the characters typed in the Text field as the watermark. You can create a text watermark to print on a document. Select options such as font size, font type, font color, and angle.
  - A Picture Watermark uses an image as the watermark. The picture file can be in .bmp, .gif, or .jpg format. You can create a picture watermark to print on a document, and select options including size and position on the page.
  - A Time Stamp Watermark uses a time stamp as the watermark. You can create a time stamp watermark to print on a document. Time stamp elements include the day, date, time, and time zone.
- Place a watermark on the first page or on every page in a document.
- Print a watermark in the foreground or background or blend it with the print job.

To print a Watermark:

1. Click **Document Options > Watermark**.
2. From the Watermark menu, select the watermark.
3. Click **Layering**, then select how to print the watermark:
   - **Print in Background** prints the watermark behind the text and graphics in the document.
   - **Blend** combines the watermark with the text and graphics in the document. A blended watermark is translucent, so you can see both the watermark and the document content.
   - **Print in Foreground** prints the watermark over the text and graphics in the document.
4. Click **Pages**, then select the pages on which to print the watermark:
   - **Print on All Pages** prints the watermark on all pages of your document.
   - **Print on Page 1 Only** prints the watermark only on the first page of the document.
5. Click **OK**.

**Printing Mirror Images**

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.
Printing Special Job Types

This section includes:
- Secure Print ............................................................................................................................................................................. 95
- Proof Print ............................................................................................................................................................................... 96
- Personal Print ......................................................................................................................................................................... 97
- Saved Job ................................................................................................................................................................................ 97
- Print With ................................................................................................................................................................................ 99

Special job types allow you to send a print job from your computer, then print it from the printer control panel. Select special job types in the Printing Preferences of the print driver.

For some special job types, for security, you can set a user name and passcode. The passcode is associated with your user name. After you set a passcode, it becomes the default passcode for any print job that requires a passcode on all Xerox® printers. You can reset the passcode at any time from any window that contains the passcode.

Notes:
- To use this feature, you must have the optional solid-state drive installed.
- Not all options listed are supported on all printers. Some options apply only to a specific printer model, configuration, operating system, or driver type.

You can find special print jobs at the printer control panel in the Walk-Up Features job type folder. At the control panel, to select Walk-Up Features, press OK.

To access special job types for a USB-connected Macintosh, verify that the Hard Drive option is installed. To verify the Hard Drive option, select System Preferences>Printers & Scanners>YourXeroxPrinter>Options & Supplies>Options>Hard Drive>Installed.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until you enter your passcode at the printer control panel.

To print using Secure Print:
1. In your software application, access the print settings. For most software applications, press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   - For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   - In Macintosh, in the Print window, click Copies & Pages, then select Xerox Features.
3. For Job Type, select Secure Print.
4. Type, then retype a passcode.
5. Click OK.
6. Select other desired printing options and click OK.

   Note: The printer holds the print job until you enter the passcode at the control panel.

7. At the control panel, to select Walk-Up Features, press OK.
8. Use the arrows to navigate to the corresponding job type folder, then press OK.
9. Navigate to your user name, then press OK.
10. To enter your passcode, use the arrow buttons, then press OK.
11. To select your print job, navigate to the corresponding job name, then press OK.
12. To select all print jobs, for All of Them, press OK.
13. Select an option.
   - To print and delete the job, press OK.
   - To delete the jobs without printing, navigate to Delete, then press OK.

Proof Print

Proof Print allows you to print one copy of a multiple-copy print job when you want to preview the results before printing the rest. After viewing the proof, you can either print the remaining copies or delete them at the printer control panel.

   Note: For details, see Using Earth Smart Settings on page 86.

To print using Proof Print:
1. In your software application, access the print settings. For most software applications, press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   - For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   - In Macintosh, in the Print window, click Copies & Pages, then select Xerox Features.
3. For Job Type, select Proof Print.
4. In the Proof Print window, for Job Name, do one of the following:
   - Type a name for the job.
   - Click the arrow to the right of the field and select a name from the list.
   - Click the arrow to the right of the field and select Use Document Name to use the name of the document.

   The print driver retains 10 names. When adding an 11th name, the name used least is deleted automatically from the list. To remove names from the list other than the selected name, select Clear List.
5. Select other desired printing options and click OK.
6. Select the number of copies, then click Print.

   The first copy prints immediately. For example, if you are printing 10 copies, the first one prints as the proof copy. The other nine copies are stored in the printer.
7. At the control panel, to select Walk-Up Features, press OK.
8. Use the arrows to navigate to the corresponding job type folder, then press OK.
9. Navigate to your print job, then press OK.
10. Select an option.
    – To print and delete the job, press OK.
    – To delete the jobs without printing, navigate to Delete, then press OK.

**Personal Print**

Personal Print allows you to store a document in the printer, then print it from the control panel.

To print using Personal Print:
1. In your software application, access the print settings. For most software applications, press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   – For Windows, click **Printer Properties**. Depending on your application, the title of the button varies.
   – In Macintosh, in the Print window, click **Copies & Pages**, then select **Xerox Features**.
3. For Job Type, select **Personal Print**.
4. Select other desired printing options and click OK.
5. At the control panel, to select Walk-Up Features, press OK.
6. Use the arrows to navigate to the corresponding job type folder, then press OK.
7. Navigate to your user name, then press OK.
8. Select an option.
   – To print and delete the job, press OK.
   – To delete the jobs without printing, navigate to Delete, then press OK.

**Saved Job**

Saved Job allows you to save a print job to a folder on the printer. Using the controls in the Saved Jobs window, you can save the job, or you can print and save the job for future use. You can also set the access to the print job as follows:

- **Public** requires no passcode and allows any user to print the file from the control panel of the printer.
- **Private** requires a passcode so that only a user with the passcode can print the file.

When the Saved Job is no longer needed, you can delete it from the control panel of the printer.
Printing a Public Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   - For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   - In Macintosh, in the Print window, click Copies & Pages, then select Xerox Features.
3. For Job Type, select Saved Job.
4. In the Saved Job window, for Job Name, do one of the following:
   - Type a name for the job.
   - Click the arrow to the right of the field and select a name from the list.
   - Click the arrow to the right of the field and select Use Document Name to use the name of the document.

   The print driver retains 10 names. When adding an 11th name, the name used least is deleted automatically from the list. To remove names from the list other than the selected name, select Clear List.
5. Select Public.
6. Click OK.
7. Select other desired printing options and click OK.
8. Select the desired settings, then click Print.
9. At the control panel, to select Walk-Up Features, press OK.
10. Use the arrows to navigate to the corresponding job type folder, then press OK.
11. Navigate to your print job, then press OK.
12. Select an option.
   - To print and store the job on the printer, select Print and Save, then press OK. To specify the number of copies, use the arrow buttons, then press OK.
   - To delete the jobs without printing, navigate to Delete, then press OK.

Printing a Private Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   - For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   - In Macintosh, in the Print window, click Copies & Pages, then select Xerox Features.
3. For Job Type, select Saved Job.
4. In the Saved Job window, for Job Name, do one of the following:
   - Type a name for the job.
   - Click the arrow to the right of the field and select a name from the list.
   - Click the arrow to the right of the field and select Use Document Name to use the name of the document.
The print driver retains 10 names. When adding an 11th name, the name used least is deleted automatically from the list. To remove names from the list other than the selected name, select Clear List.

5. To make the saved job available for you only, select Private. For Macintosh, to specify a private print job, enter a passcode.
6. Type, then retype a passcode.
7. Click OK.
   
   **Note:** The printer holds the print job until you enter the passcode at the control panel.

8. Select other desired printing options and click OK.
9. Select the desired settings, then click Print.
10. At the control panel, to select Walk-Up Features, press OK.
11. Use the arrows to navigate to the corresponding job type folder, then press OK.
12. Navigate to your user name, then press OK.
13. To enter your passcode, use the arrow buttons, then press OK.
14. To select your print job, navigate to the corresponding job name, then press OK.
15. Select an option.
   – To print and store the job on the printer, select Print and Save, then press OK. To specify the number of copies, use the arrow buttons, then press OK.
   – To delete the jobs without printing, navigate to Delete, then press OK.

**Print With**

Print With allows you to print stored private and public saved jobs with the current print job. For example, print a cover letter with a set of saved documents such as brochures or price lists.

   **Note:** This job type is only available on printers that are connected to a network with bi-directional communication enabled.

For more information, refer to the help for your print driver. To access Xerox® Print Driver help, in the Print Driver window, click Help (?).
This chapter includes:

- **Maintenance and Cleaning** ................................................................. 102
- **Ordering Supplies** .............................................................................. 119
- **Moving the Printer** ............................................................................ 122
Maintenance and Cleaning

This section includes:

- General Precautions .......................................................................................................................................................... 102
- Cleaning the Printer .......................................................................................................................................................... 104
- Accessing Maintenance Information ........................................................................................................................ 111
- Routine Maintenance.......................................................................................................................................................... 112

General Precautions

To maintain and operate your printer safely, follow each of the precautions mentioned in this section.

Avoiding Damage to the Printer

- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time.
- Do not open covers and doors during printing.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure any parts removed during cleaning are replaced before you plug in the printer.

Avoiding Hot Printer Parts

⚠️ WARNINGS:
- Internal parts of the printer can be hot. Use caution when doors and covers are open.
- Parts of the printer are hot and need time to cool down before moving or packing the printer. To avoid personal injury or printer damage, wait 30 minutes for the ink to solidify and the printhead to cool down.

Caution When Cleaning

⚠️ CAUTIONS:
- When cleaning your printer, do not use organic or strong chemical solvents or aerosol cleaners.
- Do not pour fluids directly into any area of the printer.
- Use supplies and cleaning materials only as directed in the Maintenance section of this manual.
- Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

⚠️ WARNING: Keep all cleaning materials out of the reach of children.
Maintenance Restrictions

⚠️ **WARNING:** Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.
Cleaning the Printer

This section includes:

- Cleaning the Printer Exterior ................................................................. 104
- Cleaning the Paper Release Blade ......................................................... 105
- Cleaning the Feed Rollers ..................................................................... 107

Cleaning the Printer Exterior

Regular cleaning keeps the control panel and its display free from dust and dirt. Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

⚠️ WARNING: To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet before performing maintenance.

To remove stains, use a soft lint-free cloth dampened with a neutral detergent or water.
Cleaning the Paper Release Blade

Cleaning the paper release blade removes ink residue, which can cause streaks, smears, and other marks on the printed page.

To clean the paper release blade:
1. Open exit door B.

2. Lift the lower paper guide toward the front of the printer.

3. Locate the clear plastic strip on the paper guide. Wipe the entire length of the lower half, especially the side facing you, with a cloth pre-moistened in 90% isopropyl alcohol.
4. Lower the paper guide to its original position.

5. Close exit door B.
Cleaning the Feed Rollers

Periodically inspect the feed rollers in each of the installed trays, and clean them if paper dust or other residue is visible. Dirt on the feed rollers can cause paper jams or deteriorate print quality.

To clean the feed rollers:
1. Open exit door B.
2. To clean the gray exit rollers, use a clean, soft cloth.
3. Close exit door B.
4. Open tray 1.

5. Clean the gray pick roller using a clean, soft cloth.

6. Close the tray.
7. Clean the rollers at the top of the tray 2 slot.
   a. Remove tray 2 from the printer.
b. Inside the printer, to the right of the gray pick roller assembly, locate the orange release lever. To release the roller assembly, pull the release lever toward you.

Note: Remember the position of the roller assembly for reinstallation.

c. Grasp and pull the pick roller assembly straight down to remove it from the printer.

d. To clean the pick roller, lay a strip of clear packing tape on a table, sticky side up. Run the pick roller assembly along the length of the tape.

Note: Do not use masking tape or duct tape because they can leave residue on the roller.
8. Reinstall the pick roller assembly.
   a. Hold the pick roller assembly vertically so that it aligns with the spaces into which it fits.
   b. Gently snap the assembly into the slots. Ensure that the assembly is reinstalled in the same position as it was when you removed it from the printer.
   c. Gently swing the pick roller assembly up until it clicks in place.

9. To clean the separator roller in the tray, rub clear packing tape on it.

10. Reinstall tray 2. Ensure that the door is closed completely.
11. Repeat this procedure for any installed optional paper trays.
Accessing Maintenance Information

This section includes:

- Viewing Billing Meters Information ................................................................. 111
- Printing the Supplies Usage Page .................................................................... 111
- Printing the Usage Profile .................................................................................. 111

You can use the Maintenance Information pages to access helpful information about usage, maintenance kit, and printer supplies.

Viewing Billing Meters Information

Billing Meters allow you to view impression count details for the printer and to print Billing Meter reports. Billing Meters track the total number of page sides, not sheets, printed for the life of the printer. You cannot reset the billing meters.

To view billing meters:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Billing Meters, then press OK.
3. For a description of each billing meter, select the meter, then press Help (?).

Printing the Supplies Usage Page

The Supplies Usage page shows the percentage of ink used, the estimated amount of ink remaining, and the life remaining on the maintenance kit.

To print the Supplies Usage page:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Supplies Info, then press OK.
3. To print the Supplies Usage page, navigate to it, then press OK.

Printing the Usage Profile

The usage profile page shows a summary of billing meter information, including page count, maintenance kit, and supply usage information.

To print the usage profile:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Information Pages, then press OK.
3. To print the Usage Profile page, navigate to it, then press OK.
Routine Maintenance

This section includes:
- Adding ColorQube Ink ................................................................. 112
- Emptying the Waste Tray .............................................................. 115
- Replacing the Maintenance Kit ...................................................... 117

Adding ColorQube Ink

When the ink is low, a warning message appears on the control panel. When the ink must be replaced, an error message appears on the control panel. You can add ink any time the printer is idle.

Notes:
- Keep ink in its packaging until you are ready to use it.
- Identify the ink by number, color, and shape.
- Do not force the solid ink when inserting it into the printer.
- To avoid jams, never insert broken solid ink into the printer.

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for your printer model.
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580supplies
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880supplies

To add ColorQube ink:
1. Remove any paper or other media from the output tray.
2. Open door C.
3. To access to ink bin slots, ensure that the door is extended fully.

4. Locate the bin that is low on ink. A label above each bin indicates the corresponding solid ink color and shape.

5. Remove the solid ink from its packaging.

6. Place the solid ink into the opening of the appropriate ink loading bin. Do not force the solid ink into the bin. Each color is shaped uniquely to fit into the correct bin.

   Note: The ink shapes can vary by printer model. Ensure that you order the correct ink for your specific printer model.
7. Close door C. Until the printer is ready to print, a warm-up message appears on the printer control panel.

⚠️ **CAUTION:** Use of ink other than Genuine Xerox® ColorQube solid ink can affect print quality and printer reliability. It is the only ink designed and manufactured under strict quality controls by Xerox for specific use with this printer.

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for your printer model.

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580supplies
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880supplies

⚠️ **CAUTION:** Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Emptying the Waste Tray

When the waste tray is full, the control panel displays an Empty Waste Tray message.

To empty the waste tray:
1. Open maintenance door D.

2. Remove the waste tray, labeled B, from the waste tray slot.

⚠️ **WARNING:** The waste tray can be hot; handle it carefully.

**Note:** The waste tray locks when the printer is in a warm-up cycle or following the Eliminate Light Stripes troubleshooting routine.

3. If the tray is locked, follow these steps.
   a. Close maintenance door D.
   b. Wait 15 minutes.
   c. Open maintenance door D.
   d. Remove the waste tray from the printer.
4. Empty the waste tray in a waste container. Twist the waste tray slightly to dislodge the waste ink. The ink is non-toxic and can be discarded as normal office waste.

   **CAUTION:** Do not attempt to reuse the waste ink in the printer; it can damage the printer. This damage is not covered under the printer warranty.

   ![Image of a waste tray being emptied into a trash can]

   **Note:** The waste tray must be out of the printer for more than five seconds to clear the Empty Waste Tray message on the control panel.

5. Insert the waste tray completely into the printer.
6. Close maintenance door D.
Replacing the Maintenance Kit

The maintenance kit contains a maintenance roller that keeps the surface of the imaging drum clean and oiled.

When the maintenance kit requires replacement, a message appears on the control panel.

Note: When the printer control panel displays a message that the maintenance kit is low, order a new maintenance kit.

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for your printer model.
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580supplies
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880supplies

To replace the maintenance kit:
1. Open maintenance door D.

⚠️ WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

From the maintenance kit slot, remove the maintenance kit, labeled A. For full installation and disposal information, follow the illustrated instructions included with the maintenance kit.
2. Insert the replacement maintenance kit and push it into the maintenance kit slot completely.  
   **Note:** If you do not insert the kit fully, a message appears on the control panel: Maintenance Kit is Missing.

3. Close maintenance door D.
Ordering Supplies

This section includes:

- Locating the Serial Number ................................................................. 119
- When to Order Supplies ......................................................................... 119
- Consumables .......................................................................................... 120
- Viewing the Maintenance Kit Status ..................................................... 120
- Customer Replaceable Units .................................................................. 120
- Recycling Supplies ................................................................................ 121

Locating the Serial Number

Before you order supplies or contact Xerox for assistance, locate the printer serial number. The serial number is located behind front door A on the printer frame. You can also view the serial number on the printer control panel.

To view the printer serial number:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Printer Identification, then press OK.
3. Navigate to Serial #.

When to Order Supplies

The control panel displays an error message when supplies must be replaced. To avoid interruptions to your printing, order supplies when a message first appears on the control panel.

To view information about the remaining life of supplies:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press OK.
2. Navigate to Supplies Info, then press OK.
3. To print the Supplies Usage page, navigate to it, then press OK.

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for your printer model.
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580supplies
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880supplies

⚠️ CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
**Consumables**

Consumables are printer supplies that get depleted during the operation of the printer. Consumable supplies for this printer are the Genuine Xerox® ColorQube solid ink in cyan, magenta, yellow, and black. The ink shapes can vary by printer model. Ensure that you order the correct ink for your specific printer model.

⚠️ **CAUTION:** Use of ink other than Genuine Xerox® ColorQube solid ink can affect print quality and printer reliability. It is the only ink designed and manufactured under strict quality controls by Xerox for specific use with this printer.

To save ink, leave the printer turned on at all times. To conserve energy use, the printer uses Power Saver when inactive. For details, see **Modifying Power Settings** on page 33.

**Viewing the Maintenance Kit Status**

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

The maintenance kit is the only routine maintenance item for this printer. Replacement maintenance kits are available through your local reseller or on the Xerox Supplies website for your printer. Extended-capacity maintenance kits are available for your printer.

- Xerox® ColorQube 8580 Color Printer: [www.xerox.com/office/CQ8580supplies](http://www.xerox.com/office/CQ8580supplies)
- Xerox® ColorQube 8880 Color Printer: [www.xerox.com/office/CQ8880supplies](http://www.xerox.com/office/CQ8880supplies)

To view the maintenance kit status:
1. At the printer control panel, to navigate to the Information Menu, use the arrows, then press **OK**.
2. Navigate to Supplies Info, then press **OK**. Navigate to Maintenance Kit Life, then press **OK**. The life remaining for the maintenance kit appears.

See also:
**Replacing the Maintenance Kit** on page 117

**Customer Replaceable Units**

Customer replaceable units (CRUs) are printer parts that can be replaced without need for technical service intervention. These parts have longer rated lives than routine maintenance items. Each customer replaceable unit includes installation instructions.

This printer has one CRU part. The feed roller kit replaces the two feed rollers.
Recycling Supplies

For information on Xerox® supplies recycling programs, go to:

- Xerox® ColorQube 8580 Color Printer www.xerox.com/gwa
- Xerox® ColorQube 8880 Color Printer www.xerox.com/gwa
Moving the Printer

This section includes:

- Precautions for Moving the Printer ................................................................. 122
- Moving the Printer Within the Office ............................................................. 123
- Preparing the Printer for Shipment ............................................................... 124

Precautions for Moving the Printer

To avoid injuring yourself or damaging the printer:

⚠️ **WARNINGS:**

- Parts of the printer are hot and need time to cool down before moving or packing the printer. To avoid personal injury or printer damage, wait 30 minutes for the ink to solidify and the printhead to cool down.
- Before you move the printer, remove any optional trays.
- To lift the printer, always use at least two people to grasp the hand holds on each side of the printer.

⚠️ **CAUTIONS:**

- Before you move the printer, see Moving the Printer Within the Office on page 123.
- Keep the printer level. Tilting the printer can cause the ink to spill inside.
- Wait for the printer to complete the cool-down period for the ink to solidify. The printer fans shut down when the printer is cool enough to move. Always allow the printer to cool before it is moved to avoid ink spills that can damage the printer.
- Wait for the printer to complete its power off sequence. Then unplug all cables and cords. Never turn off the printer by pulling the power cord or using a power strip with a power switch.
Moving the Printer Within the Office

To move the printer:
1. Close the printer doors.
2. To turn off the printer, on the right rear side of the printer, under the I/O door, use the power switch.
3. Within 30 seconds, at the control panel, select **Shutdown for Moving Printer**, then press **OK**.
4. After the cool-down cycle is complete, unplug the printer.
   
   **CAUTION:** Do not unplug the printer until the cooling sequence completes and the printer turns off.
5. Before you move the printer, remove any optional trays.
6. To lift the printer, always use at least two people to grasp the hand holds on each side of the printer.

After moving the printer:
1. Reinstall any parts you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and turn on the printer.
Preparing the Printer for Shipment

Removing the Maintenance Kit and Waste Tray

Before you ship the printer, remove the maintenance kit and waste tray.

⚠️ **CAUTION:** Shipping the printer with the maintenance kit and waste tray installed can damage the printer.

To remove the maintenance kit and waste tray:

1. Open maintenance door D.

2. From the maintenance kit slot, remove the maintenance kit, labeled A. Place the tray in a plastic bag for storage.
3. Remove the waste tray, labeled B, from the waste tray slot.

⚠️ **WARNING:** The waste tray can be hot; handle it carefully.

4. Empty the waste tray in a waste container. Twist the waste tray slightly to dislodge the waste ink. The ink is non-toxic and can be discarded as normal office waste.

5. Close the printer doors.
**Turning Off the Printer**

The Shutdown for Moving Printer option causes the fan to run and displays a cool-down time of 30 minutes on the control panel. When the printer is cool enough to move, the printer fan shuts down.

**Note:** When you want to shut down the printer but do not need to move it, you can use the Standard Shutdown option.

To turn off the printer:
1. To turn off the printer, on the right rear sided of the printer, under the I/O door, use the power switch.

2. Within 30 seconds, at the control panel, select **Shutdown for Moving Printer**, then press **OK**.
3. After the cool-down cycle is complete, unplug the printer.

⚠️ **CAUTION:** Do not unplug the printer until the cooling sequence completes and the printer turns off.

**Packing the Printer for Shipment**

Repack the printer and its options using the original packing material and boxes or a Xerox® Repackaging Kit. Additional instructions for repacking the printer are provided in the Repackaging Kit. To uninstall options, reverse the steps in the installation instructions. If you do not have all the original packaging, or are unable to repack the printer, contact your local Xerox reseller, or go to:

- Xerox® ColorQube 8580 Color Printer [www.xerox.com/office/CQ8580support](http://www.xerox.com/office/CQ8580support)
- Xerox® ColorQube 8880 Color Printer [www.xerox.com/office/CQ8880support](http://www.xerox.com/office/CQ8880support)

⚠️ **CAUTION:** Failure to repack the printer properly for shipment can result in damage not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper moving.
This chapter includes:

- **General Troubleshooting** .......................................................................................................................... 128
- **Paper Jams** ............................................................................................................................................... 134
- **Troubleshooting Print Quality** .............................................................................................................. 152
- **Getting Help** ........................................................................................................................................... 166
General Troubleshooting

This section includes:

- Minimizing Ink Usage
- Restarting the Printer
- Printer Does Not Turn On
- Printer Resets or Turns Off Frequently
- Printing Takes Too Long
- Cannot Print to the Printer with a USB Connection
- Cannot Print to the Printer with a Network Connection
- Document Fails to Print
- Document Prints From Wrong Tray
- Printer Makes Unusual Noises
- Date and Time are Incorrect
- Automatic 2-Sided Printing Problems

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply restarting the printer.

Minimizing Ink Usage

To save ink, leave the printer turned on at all times. For more information about minimizing ink usage, go to the Xerox Support website for your printer model:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support

Restarting the Printer

Restarting the Printer Using the Restart Option

1. At the printer control panel, use the arrows to navigate to Shut Down, then press OK.
2. Navigate to Restart Printer, then press OK.
3. When the prompt appears, press OK.
Restarting the Printer Using the Power Switch

1. Close the printer doors.
2. Turn off the printer using the power switch on the back of the printer.
3. At the printer control panel, within 10 seconds after you turn off the printer, to select Standard Shutdown, press **OK**.
   - Wait 30 seconds after the printer turns off before proceeding to the next step.
   - If the printer does not turn off after two minutes, it is not able to complete a standard power off sequence. Disconnect the power cord, wait 30 seconds, and reconnect it.
4. Turn on the power switch.
   If restarting the printer does not resolve the problem, see the table in this chapter that best describes the problem.

Printer Does Not Turn On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power switch is not turned on.</td>
<td>Turn on the switch.</td>
</tr>
<tr>
<td>The power cord is not correctly plugged into the outlet.</td>
<td>Turn off the printer power switch, and plug the power cord securely into the outlet.</td>
</tr>
</tbody>
</table>
| Something is wrong with the outlet connected to the printer. | • Plug another electrical appliance into the outlet and see if it operates properly.  
• Try a different outlet. |
| The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications. | Use a power source with the specifications listed in the Electrical Specifications on page 174. |

⚠️ **CAUTION:** Plug the three-wire cord (with grounding prong) directly into a grounded AC outlet only. Do not use a power strip. If necessary, contact a licensed electrician to install a properly grounded outlet.

Printer Resets or Turns Off Frequently

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications.</td>
<td>Use a power source with the specifications listed in the Electrical Specifications on page 174.</td>
</tr>
</tbody>
</table>
| The printer is plugged into an Uninterruptible Power Supply (UPS) or shared power strip. | • Do not use a UPS. Only use an extension cord, power strip, or surge protector designed to handle the electrical current capacity of the printer.  
• If you plug the printer into a 20 amp surge protector, do not plug any other device into the surge protector.  
• Do not plug the printer into the same outlet with other high-power devices, such as kitchen appliances. |
Probable Causes | Solutions
---|---
A network configuration problem exists. | Unplug the network cable. If the problem is resolved, contact your network administrator to reconfigure your network installation.
A system error occurred. | Contact your Xerox representative with the error code and message. Check the control panel fault history. For details, see Viewing Error Messages on the Control Panel.

### Printing Takes Too Long

Probable Causes | Solutions
---|---
The printer is set to print on a paper type that requires slower printing. | Certain paper types, like heavyweight paper and transparencies, take more time to print. Ensure that the print driver and control panel are set to the proper paper type.
The printer is in Power Saver mode. | Wait for the printer to come out of Power Saver mode.
The way the printer was installed on the network could be an issue. | • Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds.
• To test the speed of the printer, print some information pages such as the Office Demo Page. If the page prints at the rated speed of the printer, you could have a network or printer installation issue. For additional help, contact the system administrator.
The print-quality mode in the driver is set to Photo. | • Reduce the print-quality mode.
• No action needed. Photo print-quality mode takes longer to print.
The job is complex. | Wait. No action needed.
When printing without interruption for more than two hours, to maintain a normal operating temperature, the printer activates a slow down mode. | Before you resume use of the printer, allow the printer to cool down or stagger large print jobs.

### Cannot Print to the Printer with a USB Connection

Probable Causes | Solutions
---|---
The USB cable is connected to a hub or adapter. | Disconnect the USB cable from a hub or adapter, and connect it from the computer to the printer directly.
The USB Port setting for the printer is not enabled. | Enable the USB port.
1. At the printer control panel, use the arrows to navigate to Printer Setup, then press OK.
2. Navigate to Connection Setup, then press OK.
3. Navigate to USB Setup, then press OK.
4. If the USB Port is set to Off, to set it to On, press OK.
### Troubleshooting

#### Xerox® ColorQube 8580/8880 Color Printer 131

**User Guide**

#### Probable Causes

<table>
<thead>
<tr>
<th></th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The wrong cable is used, or the cable is too long.</td>
<td>Use a standard A/B USB 2.0 cable. Do not use a USB cable that is longer than 5 meters or 16.4 feet. For details, see the <em>Installation Guide</em> that is packaged with your printer.</td>
</tr>
</tbody>
</table>
| The USB cable is defective or damaged. | • To test the USB cable, connect it to another computer that is working properly, then try to print a document. If the document does not print, the USB cable may be defective or damaged.  
• Replace the USB cable. |

---

#### Cannot Print to the Printer with a Network Connection

Connectivity problems can prevent you from printing.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The IP address that the print driver is using is not the one currently assigned to the printer. | To troubleshoot the problem and find a solution, do the following.  
1. Verify that the printer port is configured to use the same IP address or DNS name that the printer is using.  
2. If necessary, configure the port to use the correct IP address or DNS name.  
To prevent the IP address from changing in the future, do any of the following that apply:  
• Assign a static IP address to the printer.  
• For assistance, contact your system administrator. |

*Note:* If your printer is assigned an IP address dynamically, the IP address can change periodically even after you have installed the print driver.

---

See also:

- *Viewing the Automatic IP Address* on page 36
- *Assigning the IPv4 Address Manually* on page 38
## Troubleshooting

### Document Fails to Print

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected tray has wrong paper size loaded.</td>
<td>Ensure that the paper type is set properly in the driver and at the printer control panel. For details, see <a href="#">Loading Paper</a> on page 53.</td>
</tr>
</tbody>
</table>
| The way the printer was installed on the network could be an issue. | • Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds.  
  • To test the printer, print some information pages such as the Office Demo Page. If the page prints, you could have a network or printer installation issue. For additional help, contact the system administrator. |
| Application and print driver have conflicting tray selections. | 1. Check the tray selected in the print driver.  
  2. Go to the page setup or printer settings of the application from which you are printing.  
  3. Set the paper source to match the tray selected in the print driver or set the paper source to Automatically Select. |

### Document Prints From Wrong Tray

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| Application and print driver have conflicting tray selections. | 1. Check the tray selected in the print driver.  
  2. Go to the page setup or printer settings of the application from which you are printing.  
  3. Set the paper source to match the tray selected in the print driver or set the paper source to Automatically Select. |

**Note:** Set the paper source tray selection to Automatic to have the print driver select the tray.

### Printer Makes Unusual Noises

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>One of the paper trays is not installed correctly.</td>
<td>Open and close the paper tray from which you are printing.</td>
</tr>
<tr>
<td>Tray 1 roller is out of position.</td>
<td>To reset the roller position, open then close front door A.</td>
</tr>
<tr>
<td>There is an obstruction or debris inside the printer.</td>
<td>Turn off the printer and remove the obstruction or debris. If you cannot remove it, contact your Xerox representative.</td>
</tr>
</tbody>
</table>
**Date and Time are Incorrect**

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The correct date and time are not set.</td>
<td>To set the printer date and time, at the control panel, navigate to Printer Setup&gt;Printer Controls&gt;Date and Time.</td>
</tr>
</tbody>
</table>

See also: Setting the Date and Time on page 32

**Automatic 2-Sided Printing Problems**

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is a setting mismatch between the printer control panel and the print driver. The printer is set to 2-sided printing at the control panel but the job that was sent did not specify 2-sided printing in the print driver.</td>
<td>Select 2-sided printing in the print driver before you print the job. For details, see Printing on Both Sides of the Paper on page 89.</td>
</tr>
</tbody>
</table>
| The correct paper size and type are not selected at the control panel.        | 1. Remove the paper from the paper tray.  
2. Load paper into the tray, then insert it back into the printer.  
3. Adjust the width guides until they touch the edges of the paper.  
4. Ensure that the paper type is set properly in the driver and at the printer control panel. For details, see Loading Paper on page 53. |
| Unsupported or incorrect paper.                                                | • Ensure that you are using the correct paper. For details, see Supported Paper on page 46.  
• Do not use unsupported paper, media, or paper heavier than 120 g/m² for automatic 2-sided printing. For details, see Supported Paper Types and Weights for Automatic 2-Sided Printing on page 49.|
| Your printer model is not configured with automatic 2-sided printing.         | Use manual 2-sided printing to print the job. For details, see Options and Upgrades on page 23. For details, see Using Manual 2-Sided Printing on page 90. |
Paper Jams

This section includes:

- Minimizing Paper Jams .................................................................................................................................................... 134
- Clearing Paper Jams ......................................................................................................................................................... 136
- Troubleshooting Paper Jams ........................................................................................................................................... 149

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path. To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do not reload paper that has jammed.

The following can cause paper jams:

- Selecting the incorrect paper type in the print driver.
- Using damaged paper.
- Using unsupported paper.
- Loading paper incorrectly.
- Overfilling the tray.
- Adjusting the paper guides improperly.

Avoid the following:

- Polyester coated paper that is designed specially for inkjet printers.
- Highly glossy or coated paper.
- Paper that is folded, wrinkled, or excessively curled.
- Fanning transparencies before loading in the paper tray.
- Loading more than one type, size, or weight of paper in a tray at the same time.
- Loading hole punched paper or paper with folded corners or staples in the document feeder.
- Overfilling the paper trays.
- Allowing the output tray to overfill.
- Allowing the output tray to fill with more than a few transparencies.
To prevent paper jams:

- Use only supported paper. For details, see Supported Paper on page 46.
- Follow proper paper handling and loading techniques.
- Always use clean, undamaged paper.
- Avoid paper that is curled, torn, moist, creased, or folded.
- To separate the sheets before loading into the tray, fan the paper.
- Observe the paper tray fill line; never overfill the tray.
- Remove transparencies from the output tray immediately after printing.
- Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.
- After loading the trays, select the correct paper type and size on the control panel.
- When printing, select the correct type and size in the print driver.
- Store paper in a dry location.
- Use only Xerox paper and transparencies designed for the printer.

See also:

  Paper Tips Page on page 48
  Supported Paper on page 46
Clearing Paper Jams

This section includes:

- Clearing Jams at Front Door A ................................................................. 137
- Clearing Jams at Exit Door B ........................................................................ 139
- Clearing Jams at Tray 2 .................................................................................. 141
- Clearing Jams at Trays 3, 4, or 5 ................................................................. 145

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do not reload paper that has jammed.

Notes:

- Use only Xerox® supported paper types, sizes, and weights for any paper tray.
- Print custom-size paper from Tray 1 only.

See also:

Operational Safety on page 12
Printer Symbols on page 15
Supported Paper on page 46
Clearing Jams at Front Door A

1. To open front door A, on the front of the printer, pull up the latch.

2. Lift the paper guide that is behind the front door until it snaps into the up position, then gently pull out any jammed paper.

3. Check for any jammed paper.
4. To remove any jammed paper, grasp the paper and gently pull it up and out in the direction as indicated.

5. Confirm that all paper fragments are removed.
6. Lower the paper guide, then push the paper guide back to its original position until it snaps in place.
7. Close front door A.

8. If you did not locate the jam, check exit door B.
9. If the control panel continues to indicate a paper jam, check for paper jams in the remaining trays. For details, see Clearing Paper Jams on page 136.
Clearing Jams at Exit Door B

1. Open exit door B.

2. To remove any jammed paper, grasp the paper and gently pull it up and out in the direction as indicated.

3. If you did not locate the jammed paper, to search further, lift the paper guides.
4. To remove any jammed paper, grasp the paper and gently pull it up and out in the direction as indicated.

5. Close exit door B.

6. If you did not locate the jam, check front door A.
7. If the control panel continues to indicate a paper jam, check for paper jams in the remaining trays. For details, see Clearing Paper Jams on page 136.
Clearing Jams at Tray 2

1. Remove tray 2 from the printer.

2. Remove the top sheet of paper from the paper tray.
3. Verify that the paper is loaded correctly in the tray and that the guides are pressed firmly against the paper.
   a. Press and slide the length guide until the arrow points to the appropriate paper size and the guide clicks into place.

   ![Image of length guide adjustment]

   b. Slide the width guides until the arrows point to the appropriate paper size on the bottom of the tray and the guides click into place.

   ![Image of width guide adjustment]

   **Note:** When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.
4. Check for any jammed paper that hangs down from the top of the tray slot.

Note: Do not pull paper from the tray slot.

5. To remove jammed paper that hangs from the tray slot, do the following.
   a. To open front door A, on the front of the printer, pull up the latch.

   b. Pull the jammed paper out of the printer slowly. Confirm that all paper fragments are removed.
c. Close front door A.

6. Insert tray 2 into the printer, then push it all the way in.
Clearing Jams at Trays 3, 4, or 5

1. Remove the tray from the printer. Remove all lower paper feed trays.

2. Remove the top sheet of paper from the paper tray.
3. Verify that the paper is loaded correctly in the tray and that the guides are pressed firmly against the paper.
   a. Press and slide the length guide until the arrow points to the appropriate paper size and the guide clicks into place.

   b. Slide the width guides until the arrows point to the appropriate paper size on the bottom of the tray and the guides click into place.

   **Note:** When the paper guides are adjusted correctly, a small space between the paper or media and the guides is normal.
4. Check for any jammed paper that hangs down from the top of the tray slot.

5. If paper protrudes from the base of the tray, gently pull it up and out in the direction shown. In order to clear the paper jam, remove the tray directly above the jam where the bottom of the paper is visible.
6. Confirm that all paper fragments are removed.
7. Replace all trays, then push each one completely into the printer.
Troubleshooting Paper Jams

This section includes:

- Multiple Sheets Pulled Together .......................................................... 149
- Paper Misfeeds .................................................................................... 150
- Paper Jam Message Stays On .............................................................. 150
- 2-Sided Printing Jams ........................................................................ 151

Multiple Sheets Pulled Together

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The edges of the paper are not even.</td>
<td>Remove the paper, align the edges, and then reload it.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Too much static electricity is present.</td>
<td>• Try a new ream of paper.</td>
</tr>
<tr>
<td></td>
<td>• Do not fan transparencies before loading them in the paper tray.</td>
</tr>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Use only Xerox approved paper. For details, see Supported Paper on page 46.</td>
</tr>
<tr>
<td>The relative humidity of the room is too high.</td>
<td>Feed paper one sheet at a time.</td>
</tr>
</tbody>
</table>


## Paper Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper is not correctly positioned in the tray.</td>
<td>• Remove the misfed sheet and reposition the remaining paper properly in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the paper guides to fit the paper size.</td>
</tr>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The paper guides are not correctly adjusted to the paper size.</td>
<td>Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The tray contains warped or wrinkled paper.</td>
<td>Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use only Xerox approved paper.</td>
</tr>
<tr>
<td>The label sheet is facing the wrong way in the tray or labels have been removed from the sheet.</td>
<td>• Load label sheets according to the instructions from the manufacturer.</td>
</tr>
<tr>
<td></td>
<td>• Print only on one side of the sheet of labels.</td>
</tr>
<tr>
<td></td>
<td>• Use full sheet labels only.</td>
</tr>
<tr>
<td></td>
<td>• Load labels face down in Tray 1.</td>
</tr>
<tr>
<td></td>
<td>• Load labels face up in any 525-sheet paper tray.</td>
</tr>
<tr>
<td>Envelopes are loaded incorrectly in the paper tray.</td>
<td>Load the envelopes in the paper tray short-edge feed with the flaps closed.</td>
</tr>
<tr>
<td>The printer feed rollers are dirty.</td>
<td>With a clean, soft cloth, clean the feed rollers.</td>
</tr>
</tbody>
</table>

See also:
- Supported Paper on page 46
- Printing on Special Paper on page 59
- Cleaning the Feed Rollers on page 107

## Paper Jam Message Stays On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some paper remains jammed in the printer.</td>
<td>Recheck the media path and make sure that you have removed all of the jammed paper.</td>
</tr>
<tr>
<td>One of the printer doors is open.</td>
<td>Check the doors on the printer. Close any door that is open.</td>
</tr>
</tbody>
</table>
## 2-Sided Printing Jams

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>• Use only Xerox approved paper.</td>
</tr>
<tr>
<td></td>
<td>• Do not use envelopes, labels, reloaded paper, or paper heavier than 122 g/m² for automatic 2-sided printing.</td>
</tr>
<tr>
<td>Paper type is set incorrectly in the print driver.</td>
<td>Ensure that the paper type is set correctly in the print driver and the corresponding paper is loaded in the correct tray. The following types of paper can be used for automatic 2-sided printing:</td>
</tr>
<tr>
<td></td>
<td>• Plain</td>
</tr>
<tr>
<td></td>
<td>• Lightweight</td>
</tr>
<tr>
<td></td>
<td>• Letterhead</td>
</tr>
<tr>
<td></td>
<td>• Pre-Printed</td>
</tr>
<tr>
<td></td>
<td>• Pre-punched</td>
</tr>
<tr>
<td></td>
<td>• Colored Paper</td>
</tr>
<tr>
<td></td>
<td>• Lightweight Cardstock</td>
</tr>
<tr>
<td>Paper is loaded in the wrong tray.</td>
<td>Ensure that paper is loaded in the correct tray.</td>
</tr>
<tr>
<td>Tray is loaded with mixed paper.</td>
<td>Load the tray with only one type and size of paper.</td>
</tr>
</tbody>
</table>

See also:
- Supported Paper Sizes for Automatic 2-Sided Printing on page 49
- Supported Paper Types and Weights for Automatic 2-Sided Printing on page 49
- Supported Paper on page 46
Troubleshooting Print Quality

This section includes:

- Controlling Print Quality ................................................................. 153
- Printing the Troubleshooting Print Quality Page ......................... 154
- Troubleshooting Print-Quality Problems ........................................ 155
- Troubleshooting Procedures ............................................................. 160
- Advanced Troubleshooting .............................................................. 163

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem.

If the problem persists, go to:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support

⚠️ **CAUTION:** The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Contact your Xerox representative for details.
Controlling Print Quality

This section includes:

- Paper and Media ........................................................................................................................................................................ 153
- Print-Quality Modes ........................................................................................................................................................................ 153

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Note: Print driver settings override control panel settings when you print using the print driver software on your computer.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

- Use only Xerox approved paper. For details, see Supported Paper on page 46.
- Use only dry, undamaged paper.
- Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. For details, see Paper That Can Damage Your Printer on page 47.
- Ensure the paper type selected in your print driver matches the paper type on which you are printing.
- If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the print driver.
- Store your paper and other media properly for optimum print quality. For details, see Paper Storage Guidelines on page 47.

Print-Quality Modes

Select the correct print-quality setting for your print job from the print driver. For instructions on setting the print quality, see Selecting Printing Options on page 83. To control the print quality:

- Use the print-quality settings in the print driver to control print quality. If the print quality is not suitable, adjust the print-quality setting to an higher level.
- Use only Xerox approved paper. For details, see Supported Paper on page 46.
Printing the Troubleshooting Print Quality Page

The Troubleshooting Print Quality Page provides a list of common print-quality problems and tips to help solve them. You can print the Troubleshooting Print Quality page at the printer control panel or from CentreWare Internet Services.

To print the Troubleshooting Print Quality Page:
1. At the printer control panel, use the arrows to navigate to Troubleshooting, then press OK.
2. Navigate to Print Quality Problems, then press OK.
3. To select the Troubleshooting Print Quality Page, press OK.
Troubleshooting Print-Quality Problems

This section includes:

- **Pages are Blank** ................................................................................................................................................................... 155
- **Ink or Debris is on the Page** ........................................................................................................................................... 156
- **Predominant Light Stripes with Ink Missing from the Print** ..................................................................................... 156
- **Random Light Stripes are on the Page** ..................................................................................................................... 157
- **Image Prints Too Light or Too Dark** ........................................................................................................................... 157
- **Transparency Images are Too Light or Too Dark** ................................................................................................ 158
- **Colors are Incorrect or Inaccurate** .............................................................................................................................. 158
- **PANTONE Colors Do Not Match** ............................................................................................................................. 159

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem.

If the problem persists, go to:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support

**CAUTION:** The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Contact your Xerox representative for details.

### Pages are Blank

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper type that is set in the print driver does not match the paper that is loaded in the printer.</td>
<td>Ensure that the paper type is set properly in the driver and at the printer control panel.</td>
</tr>
</tbody>
</table>
| Several sheets of paper are feeding at the same time.                        | 1. Remove the paper from the tray and check for static electricity.  
2. Fan plain paper or other media, then replace it in the tray. Do not fan transparencies. |
| The paper is not correctly positioned in the tray.                           | 1. Remove the paper, tap the edges it to straighten it out, then return it to the tray.  
2. Adjust the length and width guides to fit the paper.                       |

See also: Loading Paper on page 53
**Ink or Debris is on the Page**

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper release blade is dirty.</td>
<td>Clean the paper release blade.</td>
</tr>
</tbody>
</table>
| The job is set to print 2-sided manually on pre-printed paper but the paper type is not set to 2nd Side. | • To print on pre-printed paper, in the print driver or at the control panel, select 2nd Side as the paper type.  
• To clean ink smears, at the control panel, use the Remove Print Smears procedure. |

See also:
- Cleaning the Paper Release Blade on page 105
- Using Manual 2-Sided Printing on page 90
- Removing Print Smears on page 160

**Predominant Light Stripes with Ink Missing from the Print**

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is dirt or debris in the exit door area.</td>
<td>Open the exit door, then remove debris from the paper-exit area.</td>
</tr>
<tr>
<td>The printhead is dirty.</td>
<td>At the control panel, run the Eliminate Light Stripes procedure.</td>
</tr>
</tbody>
</table>

See also:
- Cleaning the Paper Release Blade on page 105
- Eliminating Light Stripes on page 160
### Random Light Stripes are on the Page

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| One of the printhead ink jets is malfunctioning.     | • At the control panel, run the Eliminate Light Stripes procedure.  
                                                   | • To substitute an alternate jet for the malfunctioning jet, use Jet Substitution Mode. |

See also:  
Eliminating Light Stripes on page 160  
Substituting an Ink Jet on page 161

### Image Prints Too Light or Too Dark

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The print-quality mode specified is incorrect for the print job.</td>
<td>In the print driver, select the correct print-quality mode for your print job.</td>
</tr>
<tr>
<td>The paper type that is set in the print driver or at the printer control panel is incorrect.</td>
<td>If the paper you loaded is not plain, set the correct paper type and size at the control panel and in your print driver.</td>
</tr>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Use only Xerox approved paper.</td>
</tr>
</tbody>
</table>

See also:  
Selecting a Print-Quality Mode on page 86  
Supported Paper on page 46  
Printing on Special Paper on page 59
Troubleshooting

**Transparency Images are Too Light or Too Dark**

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper type is set incorrectly in the print driver.</td>
<td>Before you print the job, in the print driver or software application, for paper type, select Transparency.</td>
</tr>
<tr>
<td>The paper type that is set for the paper tray is incorrect.</td>
<td>At the printer control panel, ensure that the paper type for the paper tray that contains transparencies is set to Transparency.</td>
</tr>
<tr>
<td>The transparency type that is used is unsupported.</td>
<td>Only use transparencies that are recommended for solid ink printers.</td>
</tr>
</tbody>
</table>

See also:
Guidelines for Printing Transparencies on page 72

**Colors are Incorrect or Inaccurate**

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The wrong color ink is loaded into one of the ink loader slots.</td>
<td>Open ink loader door C, then ensure that each ink slot contains the correct color ink.</td>
</tr>
<tr>
<td>The color correction settings are incorrect.</td>
<td>Adjust the color correction settings.</td>
</tr>
</tbody>
</table>

For online support information go to:
• Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
• Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support

See also:
Adding ColorQube Ink on page 112
Image and Color Options on page 91
## PANTONE Colors Do Not Match

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The printed colors do not match the PANTONE color chart for the printer. | To match the document colors to the color chart:  
- If the option is available in your application, select a printer PPD file for printing.  
- Before you try to match PANTONE colors, turn off any non-Xerox color matching software, such as ColorSync or ICM color matching.  
- To adjust PANTONE spot color, in the PostScript print driver, select Image Options > Color Correction > Custom Automatic Color > Spot Colors.  

**Note:** Printed PANTONE color charts can fade over time or when exposed to sunlight. If the printed color charts have been exposed to light for an extended period, reprint them.  
- Compare the printed color charts with the PANTONE Color swatch available from PANTONE, Inc.  
- To preserve the color, store printed PANTONE color charts in a dark place.  

**Note:** If the paper type is unsupported, does not meet specifications, or is at the end of its useful life, color adjustments can be ineffective. |
Troubleshooting

Troubleshooting Procedures

This section includes:

- Removing Print Smears ................................................................................................................................. 160
- Printing the Light Stripes Test Page.................................................................................................................. 160
- Eliminating Light Stripes ................................................................................................................................. 160
- Substituting an Ink Jet...................................................................................................................................... 161

Removing Print Smears

To eliminate ink smears on prints:

1. At the printer control panel, use the arrows to navigate to Troubleshooting, then press OK.
2. Navigate to Print Quality Problems, then press OK.
3. Navigate to Remove Print Smears, then press OK.

Several blank pages are printed during the cleaning process.

Printing the Light Stripes Test Page

You can use the Light Stripes Test page to identify inkjet problems.

1. At the printer control panel, use the arrows to navigate to Troubleshooting, then press OK.
2. Navigate to Print Quality Problems, then press OK.
3. Navigate to Eliminate Light Stripes, then press OK.
4. To print the Light Stripes Test page, press OK.

Eliminating Light Stripes

You can use the Eliminating Light Stripes procedure to clean the printhead.

Before you begin:

- To check for incomplete or missing ink jets, or before you run the basic Eliminate Light Stripes procedure, print the Light Stripes Test Page.
- Ensure that Enhanced print-quality mode is selected in the PostScript print driver. For details, see Selecting a Print-Quality Mode on page 86.

To clean the printhead:

1. At the printer control panel, use the arrows to navigate to Troubleshooting, then press OK.
2. Navigate to Print Quality Problems, then press OK.
3. Navigate to Eliminate Light Stripes, then press OK.
4. To perform the Basic Clean Cycle, navigate to Start Basic Clean Cycle, then press OK.
   The printer performs a printhead cleaning. This procedure can take up to five minutes.
   A cleaning page and a Light Stripes Test page print.
5. If light stripes still appear on the Light Stripes Test page, repeat the basic cleaning procedure.

6. After you perform two Basic Clean cycles, if there are weak or missing color stripes, then perform the Advanced cleaning procedure.
   a. On the Light Stripes Test page, identify the color and number of the weak or missing color stripe.
   b. At the printer control panel, use the arrows to navigate to Troubleshooting, then press **OK**.
   c. Navigate to Print Quality Problems, then press **OK**.
   d. Navigate to Eliminate Light Stripes, then press **OK**.
   e. Navigate to Advanced, then press **OK**.
   f. Select the weak or missing color, then press **OK**.
      The printer prints several cleaning pages for the selected color.

7. If the problem persists after the cleaning procedure completes, repeat the procedure.

8. If the problem persists, substitute a nearby functioning jet for the missing jet. For details, see **Substituting an Ink Jet** on page 161.

### Substituting an Ink Jet

If cleaning the printhead does not recover the ink jets, you can enable Jet Substitution. Jet Substitution uses adjacent jets to cover the area that is normally covered by the problem jet. Jet Substitution requires a functioning adjacent jet to replace the weak, missing, or discolored jet.

**Note:** Perform the printhead cleaning procedure before you substitute any jets. For details, see **Eliminating Light Stripes** on page 160.

Jet Substitution does not correct conditions where three or more consecutively-numbered jets are weak or missing. For example, if Cyan jets 1, 2, and 3 are all weak or missing, you cannot use Jet Substitution mode for jet 2.

A Service Mode key prints at the bottom of the Light Stripes Test page. The Service Mode key summarizes the number of substituted jets for each color. When a jet is substituted, a black dot appears next to its jet number on the Light Stripes Test page.

**Notes:**

- You can use Jet Substitution when you print from a computer only. Do not use Jet Substitution when you print the Light Stripes Test page at the printer control panel.
- Any jets that are substituted remain substituted until you disable Jet Substitution mode. For details, see **Disabling Jet Substitution Mode** on page 162.
- If the printer solid-state drive is installed, to print any saved and stored jobs correctly, resubmit the jobs after you enable Jet Substitution.
Enabling Jet Substitution Mode
1. At the printer control panel, use the arrows to navigate to Troubleshooting, then press OK.
2. Navigate to Print Quality Problems, then press OK.
3. Navigate to Eliminate Light Stripes, then press OK.
4. To find any weak or missing jets and the jet numbers, select Light Stripes Test page, then press OK.
5. Navigate to Jet Substitution Mode, then press OK.
6. Select the color for the weak or missing jet, then press OK.
7. Use the arrow buttons to enter the number of the weak or missing jet that you identified on the Light Stripes Test page, then press OK.
8. To confirm jet changes, select an option.

Disabling Jet Substitution Mode
1. At the printer control panel, use the arrows to navigate to Troubleshooting, then press OK.
2. Navigate to Print Quality Problems, then press OK.
3. Navigate to Eliminate Light Stripes, then press OK.
4. Navigate to Turn Jet Substitution Mode Off, then press OK.
Advanced Troubleshooting

This section includes:

- Eliminating the Paper or Media as the Problem ................................................................. 163
- Isolating the Problem to the Printer or to the Application ................................................. 163
- Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server .... 164
- Troubleshooting Print-Quality Problems in the Printer ...................................................... 165

Eliminating the Paper or Media as the Problem

Damaged or unsupported paper or media can cause print-quality problems even when the printer, application, and print driver are working perfectly. Use the following guidelines to eliminate the paper as the source of the print-quality problem:

- Make sure that the printer supports the paper or media.
- Make sure that the printer is loaded with undamaged, dry paper.
- If the condition of the paper or media is in doubt, replace it with new paper or media.
- Make sure that you have the proper tray selected in the print driver and from the control panel.
- Make sure that you have the correct paper type selected in the print driver and in the control panel of the printer.

Isolating the Problem to the Printer or to the Application

When you are sure that the paper is supported and in good condition, use the following steps to isolate the problem:

1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see Printing the Troubleshooting Print Quality Pages on page 154.
   - If the pages printed properly, the printer is working properly and the print-quality problem is an application, print driver, or print server problem.
   - If the pages still have print-quality problems, the problem is in the printer.
2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server on page 164.
3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems in the Printer on page 165.
Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server

If the printer is printing properly from the control panel but you still have print-quality problems, the application, print driver, or print server could be the cause.

To isolate the problem:

1. Print a similar document from another application and look for the same print-quality problems.
   - If the document has the same print-quality problem, it is probably a print driver or print server problem.
   - If the document printed without a print-quality problem, the application is probably the cause. Restart your printer, restart the application, then print the document again.

2. Check the print driver used for the print job. Navigate to the list of printers on your computer:
   - For Windows XP SP3, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows Server 2003 and later, click Start > Settings > Printers.
   - For Windows 7, click Start > Devices and Printers.
   - For Windows 8, click Control Panel > Devices and Printers.

   Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then select Personalize > Control Panel Home > Devices and Printers.

3. Ensure that the model name in the middle of the driver matches the model name of the printer.

4. If the names do not match, install the proper print driver for the printer.

5. If the print driver name and model are correct, set the Print-Quality mode and Color Options.
   - Set the Print-Quality mode to Standard or Enhanced.
   - Set the Color Options to Automatic Color.

6. If the problem persists, delete then reinstall the print driver.
   - If the problem still persists, ensure that you are not printing through a print server. Try printing directly to the printer.

If the problem persists, go to:
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support

See also:
- Restarting the Printer on page 128
- Selecting Printing Options on page 83
Troubleshooting Print-Quality Problems in the Printer

If you have print-quality problems when printing a Demo Page or the Configuration Report from the control panel, the problem is in the printer.

To isolate the problem:
1. At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the Troubleshooting Print Quality Pages on page 154.
2. If the prints are too light to see print details, ensure that the printer is loaded with undamaged, dry, supported paper.
3. Compare the print-quality problems in your document to each of the examples in the Troubleshooting Print-Quality Pages.
   If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the action to take to resolve the problem.

If the problem persists, go to:
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support
Troubleshooting

Getting Help

This section includes:
• Control Panel Messages ................................................................. 166
• Online Support Assistant ................................................................. 166
• More Information ........................................................................... 167

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning condition occurs, the control panel displays a message informing you of the problem. In many cases, the control panel also displays an animated graphic showing the location of the problem, such as the location of a paper jam. For many status and warning messages, the control panel Help provides additional information.

Control Panel Help

To view additional information about items and selections that appear on the control panel, press the Help (?) button.

![Control Panel Help Image]

The control panel menu items also have associated help text that describes the menu item. To view the help text for a menu item, navigate to a menu item, then press the Help(?) button.

Online Support Assistant

Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve printer problems. You can find solutions for print-quality problems, paper jams, software installation problems, and more. Online Support Assistant offers the latest technical solutions and illustrated step-by-step operational tips.

To access the Online Support Assistant, go to:
• Xerox® ColorQube 8580 Color Printer: www.xerox.com/office/CQ8580support
• Xerox® ColorQube 8880 Color Printer: www.xerox.com/office/CQ8880support
More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide</td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Quick Use Guide</td>
<td>Packaged with the printer.</td>
</tr>
</tbody>
</table>
| Other documentation for your printer    | • Xerox® ColorQube 8580 Color Printer: [www.xerox.com/office/CQ8580docs](http://www.xerox.com/office/CQ8580docs)  
  • Xerox® ColorQube 8880 Color Printer: [www.xerox.com/office/CQ8880docs](http://www.xerox.com/office/CQ8880docs)  |
| Recommended Media List                  | United States:  
  • [www.xerox.com/printer-supplies/recommended-paper/enus](http://www.xerox.com/printer-supplies/recommended-paper/enus)  
  European Union:  
  • [www.xerox.com/eurpaper](http://www.xerox.com/eurpaper)  |
| Technical support information for your  | • Xerox® ColorQube 8580 Color Printer: [www.xerox.com/office/CQ8580support](http://www.xerox.com/office/CQ8580support)  
  • Xerox® ColorQube 8880 Color Printer: [www.xerox.com/office/CQ8880support](http://www.xerox.com/office/CQ8880support)  |
| PhaserSMART Technical Support automatically diagnoses problems on your network printer and proposes solutions. | [www.phasersmart.com](http://www.phasersmart.com)                      |
| Information about menus or error messages | Press the control panel Help (?) button.                               |
| Information Pages                       | Print from the control panel or from CentreWare Internet Services.     |
| CentreWare Internet Services documentation | To access CentreWare Internet Services, open a Web browser, then type the IP address for your printer.  
  In CentreWare Internet Services, click Help.                                               |
| Order supplies for your printer         | • Xerox® ColorQube 8580 Color Printer: [www.xerox.com/office/CQ8580supplies](http://www.xerox.com/office/CQ8580supplies)  
  • Xerox® ColorQube 8880 Color Printer: [www.xerox.com/office/CQ8880supplies](http://www.xerox.com/office/CQ8880supplies)  |
| A resource for tools and information, including interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs. | [www.xerox.com/office/businessresourcecenter](http://www.xerox.com/office/businessresourcecenter) |
| Local sales and support center          | [www.xerox.com/office/worldcontacts](http://www.xerox.com/office/worldcontacts) |
| Printer registration                    | [www.xerox.com/office/register](http://www.xerox.com/office/register)    |
| Xerox® Direct online store              | [www.direct.xerox.com/](http://www.direct.xerox.com/)                   |
Specifications

This appendix includes:

- Printer Configurations and Options ................................................................. 170
- Physical Specifications ....................................................................................... 172
- Environmental Specifications ........................................................................... 173
- Electrical Specifications .................................................................................... 174
- Performance Specifications ............................................................................. 175
- Controller Specifications .................................................................................. 176
Printer Configurations and Options

Standard Features

The printer provides the following features:

- 1 GHz processor
- 1-GB RAM memory, expandable up to 2-GB, available in a single DDR3 SDRAM slot that supports 1-GB or 2-GB cards.
- Ethernet 10/100/1000Base-TX
- Universal Serial Bus (USB 2.0)
- Embedded PDL support for True Adobe PostScript 3, PCL 5c emulation, JPG, TIFF, PNG, and PDF
  
  *Note:* PDF printing requires use of the optional solid-state drive.

- PCL driver print-quality modes
  - PCL Standard Mode
  - PCL Enhanced Mode

- PostScript print-quality modes
  - **Fast Color:** Provides the fastest full-color mode prints. Use this mode when you have many images and for previewing your work.
  - **Standard:** Produces crisp, bright prints at high speed and is ideal for black text. Standard mode provides the best trade-off between performance and image quality for most jobs.
  - **Enhanced:** Use this mode for CAD applications and for fine detail printing with the best overall image quality. Lines and edges are enhanced for smoothness and black and dark colors are enhanced for richness.
  - **Photo:** This mode provides the best detail and smoothness for photographic images.

- RAM collation: This setting allows the printer to store jobs in memory so that multiple copies can print in page sequence order. Page sequence order prints pages according to page sequence for the job, for example 123, 123, 123. Copy number order prints pages according to the number of copies set for the job, for example 111, 222, 333.

- Tray 1 with 100-sheet capacity
- Tray 2 with 525-sheet capacity
- Cartridge-free solid ink
Available Configurations

<table>
<thead>
<tr>
<th>Model</th>
<th>Includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xerox® ColorQube 8580 Color Printer, N</td>
<td>Standard features</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Xerox® ColorQube 8580 Color Printer, DN</td>
<td>• Standard features</td>
</tr>
<tr>
<td>Configuration</td>
<td>• Duplex Unit</td>
</tr>
<tr>
<td>Xerox® ColorQube 8880 Color Printer</td>
<td>• Standard features</td>
</tr>
<tr>
<td></td>
<td>• Duplex Unit</td>
</tr>
<tr>
<td></td>
<td>• Expanded-capacity solid ink cartridge</td>
</tr>
</tbody>
</table>

Options and Upgrades

The following options are available for your printer:

- Productivity Kit with a 32-GB mSata Solid-state drive
- Productivity Kit with expandable memory up to 2-GB, available in single DDR3 SDRAM slot that supports 1-GB or 2-GB cards
- Automatic 2-sided printing
- 1, 2, or 3 additional 525-sheet feeders

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for your printer model.

- Xerox® ColorQube 8580 Color Printer: [www.xerox.com/office/CQ8580supplies](http://www.xerox.com/office/CQ8580supplies)
- Xerox® ColorQube 8880 Color Printer: [www.xerox.com/office/CQ8880supplies](http://www.xerox.com/office/CQ8880supplies)

For details, see Printing the Configuration Page on page 25.
Physical Specifications

Standard Configuration

The standard configuration comes with trays 1 and 2.
- Width: 40.6 cm (16 in.)
- Depth: 52.1 cm (20.5 in.)
- Height: 37.0 cm (14.6 in.)
- Weight: 27.4 kg (60.5 lb.)

Specifications for Optional Trays 3-5
- Width: 40 cm (15.5 in.)
- Depth: 50.8 cm (20 in.)
- Height: 12.7 cm (5 in.)
- Weight: 5.4 kg (12 lb.)

Clearance Requirements
Environmental Specifications

Temperature
• Storage and shipping: –30° to 60°C (–22 to 140°F)
• Operating: 10–32°C (50–90°F)

Relative Humidity
• Storage and shipping: 10%–95% (non-condensing)
• Operating: 10%–80% (non-condensing)

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, defects can occur due to condensation.

Elevation

For optimum performance, use the printer at elevations below 3200 m (10,500 ft.).
Electrical Specifications

- 90–140 VAC, 47–63 Hz (maximum allowable)
- 180–264 VAC, 47–63 Hz (maximum allowable)

Default times: 1 minute (Standby) and 30 minutes (Power Saver).

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website:

www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, and Japanese governments and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.
Performance Specifications

Printing Resolution

Maximum Resolution: 2400 FinePoint

Print Speed

This table defines the maximum print speed in pages per minute (ppm) for PostScript print-quality modes.

<table>
<thead>
<tr>
<th>Print-Quality Mode</th>
<th>Tray 1</th>
<th>1-Sided, Other Trays</th>
<th>Auto 2-sided, Other Trays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Color</td>
<td>11 ppm</td>
<td>51 ppm</td>
<td>30 ppm</td>
</tr>
<tr>
<td>Standard</td>
<td>11 ppm</td>
<td>30 ppm</td>
<td>25 ppm</td>
</tr>
<tr>
<td>Enhanced</td>
<td>10 ppm</td>
<td>19 ppm</td>
<td>18 ppm</td>
</tr>
<tr>
<td>Photo</td>
<td>6 ppm</td>
<td>6 ppm</td>
<td>6 ppm</td>
</tr>
</tbody>
</table>

This table defines the maximum print speeds in pages per minute (ppm) for PCL print-quality modes.

<table>
<thead>
<tr>
<th>Print-Quality Mode</th>
<th>Tray 1</th>
<th>1-Sided, Other Trays</th>
<th>Auto 2-sided, Other Trays</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCL Standard Mode</td>
<td>11 ppm</td>
<td>20 ppm</td>
<td>18 ppm</td>
</tr>
<tr>
<td>PCL Enhanced Mode</td>
<td>11 ppm</td>
<td>11 ppm</td>
<td>11 ppm</td>
</tr>
</tbody>
</table>
Controller Specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>RISC CPU (1 GHz) processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>1-GB RAM memory, expandable up to 2-GB, available in a single DDR3 SDRAM slot that supports 1-GB or 2-GB cards.</td>
</tr>
<tr>
<td>Interfaces</td>
<td>• Ethernet 10/100/1000Base-TX</td>
</tr>
<tr>
<td></td>
<td>• Universal Serial Bus (USB 2.0)</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>Optional 32-GB mSata solid-state drive</td>
</tr>
</tbody>
</table>
Regulatory Information

This appendix includes:

- Basic Regulations ................................................................. 178
- Material Safety Data Sheets .................................................. 181
Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.
European Union

CAUTION: This is a Class A product. In a domestic environment, this product can cause radio interference in which case the user could be required to take adequate measures.

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

European Union Lot 4 Imaging Equipment Agreement Environmental Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute

Introduction

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute
Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto enabled, during the setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the environmental impact of your work. However, should you require simplex/1-sided printing, you may change the print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains less raw material and thus save resources per print, may be used in certain applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website: www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ

Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is designed and configured to enable you to reduce your electricity costs. After the last print it switches to Ready Mode. In this mode it can print again immediately if required. If the product is not used for a period of time, the device switches to a Power Saver Mode. In these modes, only essential functions remain active in order to enable reduced product power consumption.

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This delay is the result of the system “waking up” from Power Saver mode and is typical of most imaging products on the market.

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode, please consider that this device may then only switch to a lower energy level after a longer period of time or not at all.

To learn more about Xerox participation in sustainability initiatives, please visit our website at: www.xerox.com/about-xerox/environment/enus.html
Material Safety Data Sheets

For Material Safety Data information for your printer, go to:

North America
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/msds
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/msds

European Union
- Xerox® ColorQube 8580 Color Printer: www.xerox.com/environment_europe
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/environment_europe
Recycling and Disposal

This appendix includes:

- All Countries ......................................................................................................................................................................... 184
- North America ..................................................................................................................................................................... 185
- European Union .................................................................................................................................................................. 186
- Other Countries ................................................................................................................................................................. 188
All Countries

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see www.dtsc.ca.gov/hazardouswaste/perchlorate.
North America

Xerox operates an equipment take-back and reuse/recycle program. To determine if this Xerox® product is part of the program, contact your Xerox representative (1-800-ASK-XEROX).

For more information about Xerox® environmental programs, go to:

- Xerox® ColorQube 8580 Color Printer: www.xerox.com/environment
- Xerox® ColorQube 8880 Color Printer: www.xerox.com/environment
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

**Domestic/Household Environment**

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

**Professional/Business Environment**

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
Other Countries

Please contact your local waste management authority to request disposal guidance.